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CombiFlash® Rf
Installation Guide

Section 1 Introduction

1.1  Documentation Overview
This Installation Guide provides:

• Safety Information

• Unpacking instructions

• Installation instructions, including placing the 
instrument on a network and direct connections with a 
Windows computer

• Certification and warranty information.

Once you are operating the CombiFlash Rf, you may refer to 
the Help menu for operating instructions and further 
assistance.

1.2  Product Overview
The Teledyne Isco CombiFlash Rf flash chromatography 
system gives you high-productivity automation, 
programmable gradients, UV detection and peak separation, 
and automatic detection of columns and collection tube racks. 
Its small size makes it a great “personal system” and well 
suited for operation within chemical hoods and other limited 
indoor spaces.

WARNING
Avoid hazardous practices! If you use this instrument in any 
way not specified in this manual, the protection provided by 
the instrument may be impaired; this may increase your risk 
of injury.

The CombiFlash Rf system is available in different 
configurations:



CombiFlash® Rf Installation Guide

1-2

Figure 1-1  CombiFlash Rf 75 system, 10–100 mL/min, 75 psi 
(without injection valve) 

• For general-purpose Flash chromatography needs, the 
CombiFlash Rf can be factory-configured as a 10–
100 mL/min, 75 psi system that pumps two solvents to 
form a binary gradient. This configuration has an easily 
accessible fluid path that supports liquid or solid sample 
introduction, and a fixed-wavelength UV detector 
(254 nm). Optionally, the system can be configured for 
full-spectrum (200–360 nm) UV detection with 
secondary monitoring, manual solvent selection valves 
to form a binary gradient from two of four solvent inlets, 
and a 4-port manual injection valve.



Section 1  Introduction

1-3

Figure 1-2  CombiFlash Rf 200 system, 5–200 mL/min, 200 psi (with 
automatic injection valve)

• For more advanced needs, the CombiFlash Rf can be 
factory-configured as a 5–200 mL/min (delivery flow 
rate), 200 psi system that forms a binary gradient by 
automatically selecting two solvents from four inlets. 
This configuration has an automatic, self-cleaning 
injection valve for sample introduction, and 
full-spectrum (200–360 nm) UV detection with 
secondary monitoring. An internal air pump is used for 
post-run column air purging, active solvent level 
sensing, and waste full bottle detection.

Note
This Installation Guide will use the term “CombiFlash Rf” when the 
context applies to all systems. This installation guide will refer to 
the specific model name when the discussion is limited to a 
particular configuration.
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Figure 1-3  CombiFlash Rf 4x system

• To perform multiple, sequential purifications in a 
personal or workgroup setting, a 4x module can be added 
to the Rf 200 system. This configuration is known as the 
CombiFlash Rf 4x system, a fully automated four 
channel Flash chromatography system. Each of the four 
channels are independent—including separate waste 
containers with full bottle detection.

The CombiFlash Rf systems are optimized for use with 
Teledyne Isco’s RediSep® Rf columns, which are pre-packed 
with a variety of media. For example, the CombiFlash Rf can 
purify samples from 4 milligrams to more than 33 grams using 
RediSep Rf columns loaded with 4 to 330 grams of silica gel. 
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Applications include purification of organic compounds for 
drug discovery, as well as research in agrochemicals, 
petrochemicals, natural products, polymers, and catalysts.

1.3  Operating Overview
The CombiFlash Rf system is equipped with the touch screen 
display for local control. For Windows computer control, the 
CombiFlash Rf system may be controlled by the computer in 
two different ways using TCP/IP protocol—direct or network. 
A direct connection uses a cross-over cable between Ethernet 
ports on the CombiFlash Rf and computer. A network 
connection allows control from a Windows computer on an 
established network. The Windows computer must have 
Microsoft Internet Explorer 6 or newer. 

Note
Teledyne Isco recommends that you obtain assistance from your 
Information Technology department before attempting direct or 
network connections to a Windows computer.

1.3.1  Multiple Control Possibilities

The system can be accessed from the built-in touch panel and 
up to ten network computers. The touch panel shares control 
with all connected computers. The system performs the most 
recent command from any control input.

1.3.2  File Storage

To support operation from a variety of direct and network 
connections, the software and all files are stored in the 
CombiFlash Rf on an internal hard drive. This ensures that 
your compound purification methods and run history files can 
be viewed from any connection. Optionally, individual run 
history files may be saved to a USB flash drive and the hard 
drive or a networked computer, and all run history files can be 
saved to a network drive. 
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1.4  Specifications

Table 1-1 CombiFlash Rf System Specifications 1 

Rf 75 Systems
(Without Inject Valve)

Rf 200 Systems
(With Inject Valve)

Overall Dimensions 61 cm (24")×36 cm (14.1")×43 cm (17") (H×W×D)

Weight 22.3 kg (49.2 lbs) 24.5 kg (54 lbs)

Power Options Input voltage range from 100 to 240 VAC, 50/60 Hz, 
2.0 Amps maximum.

Line cord is the disconnect device. 

Line Frequency 50/60 Hz

Ambient Temperature 20 to 40°C (maximum temperature must be at least 
15°C below the boiling point of the solvent)

Humidity (when 
connected to power)

95% relative humidity maximum at 20 to 40°C

Flow Rate Range 10 to 100 ml/min 5 to 200 ml/min

Flow Rate Accuracy ±10% ±5%

Pressure Limit 2 517 kPa (75 psi) Up to 1379 kPa (200 psi) 
(column dependent)

Pressure Accuracy 10% of full scale 5% of full scale

Gradient Formation Binary gradient from A1 
and B1 solvent inlets. 
Optional manual valves 
to select from A1, A2, 
and B1, B2 inlets. 

Binary gradient from A1, 
A2, and B1, B2 solvent 
inlets. Solvent selection 
can be automatically 
controlled by the method. 

Gradient Accuracy: ±5% ±1%

Peak Detection Modes Slope or threshold

Flow Cell Pathlength 0.1 mm, ±25%

UV Detection 
Wavelength

254 nm fixed, optional 
200 to 360 nm

200 to 360 nm, optional 
200 to 780 nm UV-Vis 

Monitor Wavelength 
with Purity Ratio

Optional 200 to 360 nm, optional 
200 to 780 nm UV-Vis 
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Wavelength Accuracy ±5 nm

Fraction Accuracy ±[2ml + (flow rate ÷ 60)]

Pollution Degree 2

Electrical Safety per EN 61010-1

Installation Category II

Maximum Altitude 2000 meters

Note 1. All specifications are subject to change.
Note 2. For columns undetected by RFID, the max pressure is limited to 50 psi.

Table 1-1 CombiFlash Rf System Specifications 1 
 (Continued)

Table 1-2 CombiFlash Rf 4x System Specifications 1 

Module Dimensions 61 cm (24")×21.6 cm (8.5")×43.2 cm (17") (H×W×D)

Module Weight 13.6 kg (30 lbs)

Overall Dimensions 61 cm (24")×57.6 cm (22.6")×43 cm (17") (H×W×D)

Overall Weight 40.8 kg (90 lbs)

Power Options Input voltage range from 100 to 240 VAC, 50/60 Hz, 
2.5 Amps system maximum, 0.5 amps module 
maximum. 

Line cord is the disconnect device. 

Line Frequency 50/60 Hz

Ambient Temperature 20 to 40°C (maximum temperature must be at least 
15°C below the boiling point of the solvent)

Humidity (when 
connected to power)

95% relative humidity maximum at 20 to 40°C

Flow Rate Range 5 to 200 ml/min

Flow Rate Accuracy ±5%

Pressure Limit 2 1379 kPa (200 psi) 

Pressure Accuracy 5% of full scale
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Gradient Formation Binary gradient from A1, A2, and B1, B2 solvent inlets. 
Solvent selection can be automatically controlled by 
the method.

Peak Detection Modes Slope or threshold

Flow Cell Pathlength 0.1 mm, ±25%

UV Detection and 
Monitor Wavelength

Selectable from 200 to 360 nm range. Optional 200 to 
780nm UV-Vis detector. 

Wavelength Accuracy ±5 nm

Fraction Accuracy ±[2ml + (flow rate ÷ 60)]

Pollution Degree 2

Electrical Safety per EN 61010-1

Installation Category II

Maximum Altitude 2000 meters

Note 1. All specifications are subject to change.
Note 2. For columns undetected by RFID, the max pressure is limited to 50 psi.

Table 1-2 CombiFlash Rf 4x System Specifications 1 
 (Continued)
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Table 1-3 Component Materials List

Component Materials

Teledyne Isco 
RediSep Rf Cartridge

Virgin Polypropylene, silica-based media, polyethylene 
(HDPE) frits

Process Tubing Carbon impregnated fluoropolymer tubing

Drain Tubing Vinyl with FEP liner

Process Valves PEEK, PTFE, perfluoroelastomer

Sample Loading Cap 316 stainless steel

Sample Loading Cap 
Seal

PTFE, Elgiloy®a

Injection Valve PTFE, PCTFE

Flowcell 303 SST, Type ES Quartz, SIMRIZ SZ485

Pump 316 stainless steel, PTFE, Elgiloy®

a. Elgiloy is a registered trademark of Combined Metals of Chicago, L.L.C.
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1.5  Controls, Indicators, and Features
Figures 1-4 through 1-6 illustrate the controls on the 
CombiFlash Rf.

Figure 1-4  CombiFlash Rf Features (Front)

1. Touch Panel LCD display – Large 10.5 inch display for 
system monitoring and control.

2. USB Port – Convenient, front panel port that accepts USB 
Flash memory drive. A Flash drive may be inserted into 
this port for transferring files, importing and exporting 
methods, and performing system software updates.

3. Adjustable Column Mount – The injection valve 
assembly and upper column mount slide along this mount 
so the system can accept a variety of column sizes. 

4. On/Standby Switch – 1 = On, 0 = standby.

5. Fraction Collector Arm and Drop Former – The arm 
and drop former move to deposit liquid in the collection 
tubes.

6. Racks and Collection Tubes – Racks hold the fraction 
collection tubes. Racks include an RFID tag which the 
system uses to read the rack type and collection tube size.

3
4

1

5

6

7
8

9

10

2



Section 1  Introduction

1-11

7. Sample Injection Port – Luer-type fitting to accept the 
sample though either a solid load sample cartridge (shown) 
or a liquid injection using a syringe or similar device.

8. Injection Valve – This six-way valve is automatically 
positioned by the CombiFlash Rf according to its current 
mode of operation. Modes include column equilibration, 
sample injection, elution, column flushing, valve cleaning, 
and system purging. The injection valve is not available on 
the standard Rf 75 systems. 

9. Upper Column Mount – Secures the column inlet.

10.Lower Column Mount – Secures the column outlet.

11.Top Shelf – Allows storage of accessories and solvent 
bottles.

12.Column Expansion Ports – These ports allow the system 
to add column channels with an optional module. The 4x 
module option is not available for the 10 – 100 mL/min 
75 psi systems. 

Figure 1-5  CombiFlash Rf Features (Side)

11

12
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Figure 1-6  CombiFlash Rf Features (Back)

13.Upper Drain Tube – Liquids spilled on the top shelf are 
carried away through this tube to a user-supplied 
container.

14.External Detector – This connector is reserved for future 
peak detection capabilities.

15.Ethernet Port – An 8P8C jack for a network connection 
using a standard CAT5 cable, or for a direct connection to a 
computer using a cross-over cable.

16.RS-232 Port – Serial communication port to interface with 
expansion modules.

17.USB Port – For control of peripheral equipment such as 
the Rf 4x module. This rear panel port is also used in 
service-related functions.

18.Cooling Fan – Cools the internal electronic assemblies.

19.Check Valves – Externally-mounted pump check valves 
to simplify pump maintenance. The check valves are not 
present on the Rf 75 systems.

20 21
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20.Solvent Level Sensing Outlet Ports – uses air or 
user-supplied gas to measure the hydrostatic pressure of 
the solvent above the weighted tubing outlet. The ports are 
not present on the Rf 75 systems.

21.Solvent Inlet Ports – Accepts A and B solvents. The Rf 75 
system does not use the 4-port block. Refer to Section 3.4 
for more information on Rf 75 solvent inlet ports.

22.Optional External Gas Port – An inlet for an internal 
pump which supplies pressurized air or user-supplied gas 
for solvent level sensing, waste container full detection, 
and system/column purges. The external gas should be 
regulated to 2–5 psig before connecting the source to this 
port. The port is not present on the Rf 75 systems. 

23.Mains Power – Connects the system to AC line voltage.

24.Waste Ports – From left to right: 

• Waste Level Sense – The system uses air or 
user-supplied gas to measure the hydrostatic 
pressure of the waste above the level sense line end. 
The system will suspend operation when this level is 
too high. This port is not present on the Rf 75 
systems.

• Diverter Valve Waste – The diverter valve on the 
fraction collector arm sends fluid to this waste port. 

• Inject Valve Waste – The injection valve is cleaned 
after each run. The system directs fluids from this 
automatic cleaning routine to this port. 

25.Lower Drain Tube – This tube carries away liquids 
spilled onto the rack area.

26.Waste Level Sense – The system uses air or 
user-supplied gas to measure the hydrostatic pressure of 
the waste above the level sense line end. The system will 
suspend operation when this level is too high. Four ports 
allow you monitor the level of each waste container on the 
Rf 4x system. 

27.Column Waste – Waste fluids are sent out ports one 
through four. Tubing connected to these ports are paired 
with the waste level sense air lines and routed to a 
collection container for each channel. 
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Figure 1-7  Optional CombiFlash Rf 4x Module Features (Back)

28.From Rf – This port on the Column Waste block receives 
fluid from the diverter valve on the fraction collector arm. 

29.Valve Waste Out – The injection valves on channels 2 
through 4 are cleaned after each run. The system directs 
fluids from this automatic cleaning routine to this shared 
port. 

30.A B – reserved for future use. 

31.USB Cable – This cable connects to the USB port on the 
Rf 200 system back panel (see item 17). The Rf 200 system 
controls the operation of the Rf 4x module through this 
connection.

32.Mains Power – Connects the module to AC line voltage.

33.Waste Level Sense From Rf – Receives pressurized air 
or optional external gas from the Rf 200 system. 

26

33

32

27

3031
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1.6  Safety
Before installing, operating, or maintaining this equipment, it 
is imperative that all hazards and preventive measures are 
fully understood. While specific hazards may vary according to 
location and application, take heed in the following general 
warnings:

WARNING
Avoid hazardous practices! If you use this instrument in any 
way not specified in this manual, the protection provided by 
the instrument may be impaired.

WARNING
Liquids associated with this instrument may be classified as 
carcinogenic, biohazard, flammable, or radioactive. Should 
these liquids be used, it is highly recommended that this 
application be accomplished in an isolated environment 
designed for these types of materials in accordance with 
federal, state, and local regulatory laws, and in compliance 
with your company’s chemical/hygiene plan in the event of a 
spill.

WARNING
If you are using flammable solvents or chemicals with this 
system, vapor concentration levels may exceed the maximum 
exposure levels as recommended by OSHA Guide 1910.1000. 
To reduce those levels to a safe exposure, Teledyne Isco 
recommends that you place the system in a laboratory hood 
designed for the purpose of ventilation. This hood should be 
constructed and operated in accordance with federal state and 
local regulations. In the event of a solvent or chemical spill, 
your organization should have a plan to deal with these 
mishaps. In all cases, use good laboratory practices and 
standard safety procedures. 
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WARNING
The CombiFlash Rf has redundant safety devices to limit 
pressure to less than 210 psi (1448 kPa). RediSep columns 
smaller than 100 g are CE certified using standard IEC61010-1 
for use on the CombiFlash Rf. RediSep columns larger than 
100 g meet Pressure Vessel Directive 97/23/EC. Teledyne Isco 
strongly recommends against the use of columns rated less 
than 210 psi (1448 kPa).

1.6.1  Hazard Severity Levels

This manual applies Hazard Severity Levels to the safety 
alerts. These three levels are described in the sample alerts 
below.

CAUTION
Cautions identify a potential hazard, which if not avoided, may 
result in minor or moderate injury. This category can also warn 
you of unsafe practices, or conditions that may cause property 
damage.

WARNING
Warnings identify a potentially hazardous condition, which if 
not avoided, could result in death or serious injury.

DANGER
DANGER – limited to the most extreme situations to identify 
an imminent hazard, which if not avoided, will result in 
death or serious injury.

1.6.2  Hazard Symbols

The equipment and this manual use symbols used to warn of 
hazards. The symbols are explained in Table 1-4.



Section 1  Introduction

1-17

Table 1-4 Hazard Symbols

Warnings and Cautions

The exclamation point within the triangle is a warning 
sign alerting you of important instructions in the 
instrument’s technical reference manual.

The lightning flash and arrowhead within the triangle is a 
warning sign alerting you of “dangerous voltage” inside 
the product.

The pinch point symbol warns you that your fingers or 
hands will be seriously injured if you place them 
between the moving parts of the mechanism near these 
symbols.

Symboles de sécurité

Ce symbole signale l’existence d’instructions 
importantes relatives au produit dans ce manuel.

Ce symbole signale la présence d’un danger 
d’électrocution.

Risque de pincement. Ces symboles vous avertit que 
les mains ou les doigts seront blessés sérieusement si 
vous les mettez entre les éléments en mouvement du 
mécanisme près de ces symboles

Warnungen und Vorsichtshinweise

Das Ausrufezeichen in Dreieck ist ein Warnzeichen, das 
Sie darauf aufmerksam macht, daß wichtige 
Anleitungen zu diesem Handbuch gehören.

Der gepfeilte Blitz im Dreieck ist ein Warnzeichen, das 
Sei vor “gefährlichen Spannungen” im Inneren des 
Produkts warnt.

Vorsicht Quetschgefahr! Dieses Symbol warnt vor einer 
unmittelbar drohenden Verletzungsgefahr für Finger und 
Hände, wenn diese zwischen die beweglichen Teile des 
gekennzeichneten Gerätes geraten.
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1.7  For Additional Information
Technical assistance for the CombiFlash Rf system can be 
obtained from:

Teledyne Isco, Inc.
4700 Superior St.
Lincoln NE 68504

Phone:  (800) 228-4373 or (402) 464-0231
Fax:  (402) 465-3001
E-mail:  IscoService@teledyne.com

Advertencias y Precauciones

Esta señal le advierte sobre la importancia de las 
instrucciones del manual que acompañan a este 
producto.

Esta señal alerta sobre la presencia de alto voltaje en el 
interior del producto.

Punto del machacamiento. Sus dedos o manos seriusly 
serán dañados si usted los coloca entre las piezas 
móviles cerca de estos símbolos.

Table 1-4 Hazard Symbols (Continued)



2-1

CombiFlash® Rf
Installation Guide

Section 2 Preparation:
Rf 200 Systems

This section provides instructions for unpacking and installing 
the CombiFlash Rf 200 system. To prepare the system for 
operation, sequentially follow all instructions in sections 2.1 
through 2.12. 

Note
Section 2.14 contains an Installation Qualification checklist. If 
required, sign off the checklist entries as you successfully 
complete the following sections.

2.1  Unpacking the Unit
The CombiFlash Rf 200 system is shipped in a single carton. 
The optional 4x expansion module is shipped in a second 
carton. Carefully unpack the shipment and inspect the 
contents. 

WARNING
The system is heavy. Use a two-person lift to prevent injury.

CAUTION
Do not lift the system by the fraction collector arm. Use the lifting 
handles located on the instrument side panels. 

If there is any damage to the shipping carton or any 
components, contact the shipping agent and Teledyne Isco (or 
its authorized representative) immediately.



CombiFlash® Rf Installation Guide

2-2

WARNING
If there is any evidence that the system has been damaged in 
shipping, do not plug it into AC power. Contact Teledyne Isco 
or its authorized representative for advice.

Compare the contents of the boxes with the enclosed packing 
slips. If there are any shortages, contact Teledyne Isco 
immediately.

The fraction collector arm was stowed to prevent damage 
during shipping. The arm stowing bracket should be removed 
at this time. 

1. Loosen the bracket’s two thumbscrews along the sides of 
the arm (Figure 2-1).

Figure 2-1  Remove arm stowing bracket and spacer

2. Push the arm to the left or right remove the spacer. 

3. Store the bracket and spacer. These parts should be 
reinstalled if the system must be shipped again.

2.2  Instrument Location
The CombiFlash Rf 200 has a relatively small footprint, 
requiring about 1550 square centimeters (240 in2) of level 
bench space. Ensure that the CombiFlash Rf has at least 3 cm 
(1.25") of air space behind it for ventilation. Additional space 
may be required for solvent and waste containers. 

The optional 4x expansion module is installed to the left of the 
CombiFlash Rf 200. This module requires an additional 

Spacer

Thumbscrew

Thumbscrew
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933 cm2 (145 in2) of level bench space. Ensure that the module 
has at least 3 cm (1.25") of air space behind it for ventilation. 
Instructions for installing the 4x module can be found in 
Section 4 of this guide. 

Refer to Table 1-1 for environmental conditions and power 
requirements. 

WARNING
The system is heavy. Use a two-person lift to prevent injury.

Before making any connections to the CombiFlash Rf 200, 
place the system on the bench or in the fume hood where it 
will be operated. Temporarily position the system so you can 
access the back panels to complete the connections.

2.3  Connect Power
Ensure that the On/Standby switch below the touch screen 
panel is in the Standby position. Then, use the supplied IEC 
power cord to connect the CombiFlash Rf 200 to mains power.

WARNING
Mains power must meet the voltage, frequency, and amperage 
requirements listed on the serial number label.

WARNING
As long as the AC mains power cord is connected, power is 
inside the unit. The mains power cord is the disconnect device. 
Position the Rf 200 system so that the power cord can be 
unplugged, or use a power strip where the plug can quickly be 
removed from the outlet in the event of an emergency. 

2.4  Connect Solvent Lines

WARNING
Risk of fire ignited by electrostatic discharge. Never substitute 
the black tubing on CombiFlash systems. The black tubing 
(P/N 023-0503-06) is conductive. This tubing is required to 
dissipate static electricity.
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CAUTION
To prevent damage or premature wear to the pump and internal 
valves, clean solvent should be used. The solvent should not 
contain any dissolved solids.

The CombiFlash Rf 200 system has four solvent inlet ports on 
the back panel: two A solvents and two B solvents.

The system requires at least one A and one B solvent to form a 
binary gradient, and assumes that the B solvent is stronger 
than A. The second set of inputs allow you to form alternative 
binary gradients, or to change the B solvent mid-run. 

Accessory package P/N 60-5239-006 includes several pieces to 
complete the solvent inlet connections.

Figure 2-2 shows the recommended connections when the 
user-supplied solvent container has a 38 or 45 mm opening 
(GL 38 or GL 45). 

If the container does not have a GL 38 or GL 45 opening, omit 
the use of the cap. Ensure that the solvent and air tubing are 
secured so that the weighted filter remains at the bottom of 
the solvent source.

The Solvent Level Sensing air line connects to the back panel 
with a compression fitting. This fitting must be airtight. To 
connect tubing using the compression fittings:

1. Slide the nut and ferrule onto the tubing as shown in 
Figure 2-2. 

2. Fully insert the tubing into the threaded bulkhead fitting 
on the back panel of the system. 

3. Finger-tighten the nut onto the threaded bulkhead fitting. 
This will seat the ferrule in the fitting. 

Note
When using higher-density solvents such as dichloromethane 
(DCM), place the solvent container level with or above the 
CombiFlash Rf system. Placing solvent containers below the level 
of the system can contribute to decreased flow due to the high 
vapor pressure of DCM. This problem becomes more pronounced 
as the ambient temperature increases.
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Figure 2-2  Recommended solvent connection

60-0923-017 Ferrule

60-0923-015 
Compression Fitting Nut

60-5234-130
Label (1 of 4)

60-5235-050 38 mm Cap, or
60-5235-051 45 mm Cap

60-5234-129
Inlet Filter Assembly
(Place weighted filter at 
bottom of container.)

To Solvent Level SensingTo Solvent Supply
Connection
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2.5  Connect Waste Lines

WARNING
Risk of fire or equipment damage. Failure to connect Waste 
Port tubing may allow organic solvents to pool in unsafe areas, 
possibly creating dangerous levels of flammable vapors.

WARNING
Risk of fire ignited by electrostatic discharges. Never 
substitute the black tubing on CombiFlash systems. The black 
tubing (P/N 023-0503-06) is conductive. This tubing is required 
to dissipate static electricity.

CAUTION
Elevated flammable vapor levels are possible. Ensure that the 
waste container is adequately ventilated, preferably by placing it in 
a fume hood. 

The system has two waste outlets on the back panel: Diverter 
Valve waste and Inject Valve waste. You can route waste to a 
common collection container, or to individual containers. 

The Waste Level Sense uses air pressure to detect the liquid 
level in the common waste container. If using individual 
containers, use the waste level sense to detect the level of the 
Diverter Valve waste container. Under normal operating 
conditions it will fill faster than the Inject Valve waste 
container. Empty both containers at the same time to prevent 
overfilling the unmonitored container.

Accessory package (P/N 60-5239-006) includes parts to 
complete the waste connections. Figure 2-3 shows the 
recommended connections for user-supplied waste containers 
with either a 38 or 45 mm opening (GL 38 or GL 45).

Refer to the steps in section 2.4 to connect the tubing to the 
system using the compression fittings. Then, complete the 
connections (refer to Figure 2-3):

1. Push the three tubes through the cap. 
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Figure 2-3  Recommended waste connections, with plastic plate

60-0923-017 Ferrule

60-0923-015 
Compression Fitting Nut

60-5234-143
Waste Tubing Assembly

60-5235-053 38 mm Waste Cap, or
60-5235-054 45 mm Waste Cap

To Diverter Valve Waste 
Connection

To Waste Level
Sense Connection To Inject Valve Waste 

Connection

Tubing Stop

Ventilation Hole
(Luer fitting)
If necessary, connect 
user-supplied tubing and 
route to fume hood. (See Top View)

(Top View)

Diverter Valve Waste

 Waste Level Sense

Inject Valve Waste

Ventilation 
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2. Push the stop on the Waste Level Sense tubing against the 
cap. This ensures that the Waste Level Sense tubing is far 
enough into the container to detect when it is nearly full.

Should the container not have a GL 38 or GL 45 opening, omit 
the use of the waste cap. Ensure the solvent tubes are secured 
so they drain into the waste container. Secure the Waste Level 
Sense air tubing so its outlet is at least two inches (5 cm) 
below the container’s maximum level.

Note
When using higher-density solvents such as dichloromethane 
(DCM), ensure that the waste container is no more than 3 feet 
below the supply solvent levels. Placing solvent containers above 
the system and waste containers on the floor may cause the 
internal check valves to open and allow solvent to flow through the 
system when in the standby state.

2.6  Optional External Gas
The CombiFlash Rf 200 system has an internal air pump that 
provides compressed air for solvent and waste level sensing. 
Optionally, the system can deliver a compressed gas. Inert or 
other gases may be more suitable than air for some 
applications.

If ambient air is compatible with your solvents and waste, 
simply leave the Optional External Gas port open.

If you want to use a gas instead of air, connect user-supplied 
1/8" I.D. tubing to the Optional External Gas port. Connect the 
other end to the user-supplied compressed gas. The external 
compressed gas should be dry, filtered, and regulated to 2–5 
psi (0.14–0.34 atm, 13.8–34.5 KPa).

2.7  Connect and Route Drain Lines

WARNING
Risk of fire or equipment damage. Failure to connect drain lines 
may allow organic solvents to pool in unsafe areas, creating a 
potential for dangerous levels of flammable vapors. Improper 
draining may damage the instrument’s internal components.
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The CombiFlash Rf 200 system has drain tubes extending 
from its top shelf and back panel. The tubes drain away any 
liquid spilled on the top shelf and the tray beneath the fraction 
collection racks.

1. Test the Fraction Collector drain by connecting a vacuum 
or air supply source to the outlet end of the drain tube. 
Then, verify the presence of such vacuum or air supply 
source on the drain (Figure 2-4).

2. Test the top shelf drain by connecting a vacuum or air 
supply source to the outlet end of the drain tube. Then, 
verify the presence of such vacuum or air supply source on 
the drain (Figure 2-5).

3. Route the end of both drain tubes to a suitable waste fluid 
collection container.

Note
It may be necessary to extend the drain tube. If so, splice the 
tubing with user-supplied tubing. The user-supplied tubing should 
have an inside diameter no smaller than the existing drain tubing, 
and must be compatible with the solvents used by the system. 
Route this extension tubing to the waste collection vessel.

Figure 2-4  Fraction Collector Drain

Vacuum or 
pressurized air 
applied to the outlet 
end of the drain 
tube must exist at 
the collection tray 
drain hole.
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Figure 2-5  Top Shelf Drain

2.8  Position the System
After completing the various connections, the system can be 
moved to its operating position. Turn the system so that the 
operator can access all of the front view features and controls 
(Figure 1-4). Use care not to damage the connections, tubing, 
and cables while moving the system.

CAUTION
Ensure that the CombiFlash Rf has at least 3 cm (1.25") of air 
space behind it for ventilation. 

Position the solvent and waste containers as necessary. 

Note
When using higher-density solvents such as dichloromethane 
(DCM), place the solvent container level with or above the 
CombiFlash Rf system. Placing solvent containers below the level 
of the Rf can contribute to decreased flow due to the high vapor 
pressure of DCM. This problem becomes more pronounced as the 
ambient temperature increases.

Vacuum or 
pressurized air 
applied to the outlet 
end of the drain 
tube must exist at 
the top shelf drain 
hole.
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Note
When using higher-density solvents such as dichloromethane 
(DCM), ensure that the waste container is no more than 3 feet 
below the supply solvent levels. Placing solvent containers above 
the system and waste containers on the floor may cause the 
internal check valves to open and allow solvent to flow through the 
system when in the standby state.

2.9  Install Collection Tube Racks
Before beginning a run, you must load collection racks with 
tubes onto the system’s fraction collector tray. 

Your system was shipped with two collection tube racks. The 
following tube rack sets are available:

• 60-5237-013 – Two racks for 13×100 mm test tubes 
(8 mL). Total tubes: 216.

• 60-5237-031 – Two racks for 16×125 mm test tubes 
(15.5 mL). Total tubes: 150.

• 60-5237-032 – Two racks for 16×150/160 mm test 
tubes (18 mL). Total tubes: 150.

• 60-5237-033 – Two racks for 18×150 mm test tubes 
(25 mL). Total tubes: 140.

• 60-5237-034 – Two racks for 18×180 mm test tubes 
(30 mL). Total tubes: 140.

• 60-5237-035 – Two racks for 25×150 mm vials 
(50 mL). Total vials: 60.

• 60-5237-040 – One rack for 480 mL French square 
bottles.

• 60-5394-469 – Two racks for 28×61 mm scintillation 
vials (20 mL). Total vials: 54.

• 60-5394-468 – Two racks for 28×95 mm scintillation 
vials (40 mL). Total vials: 60.
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To load the racks:

1. Insert test tubes, vials, or bottles into the rack (Fig. 2-6).

Figure 2-6  Loading test tubes

Figure 2-7  Inserting the collection tube rack

Tube Size 
Label
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CAUTION
Risk of broken glass or equipment damage. Do not load test tubes 
longer than the length listed on the tube size label.

2. While holding the rack with the tube size label visible 
(Figure 2-7), insert the racks into the system. Slide the 
rack in until you feel it drop into its seated position. 

CAUTION
An incorrectly installed rack will cause the rack to be misaligned 
under the fraction collector arm. Misaligned racks might cause 
fractions to miss the tube opening or deposit in the wrong tube. 
Always ensure the tube size label is visible (that is, facing 
outward) and the rack is pushed in until it is seated.

When you turn the power switch to on, the system will 
automatically detect the type of rack, and configure program 
settings accordingly. Later, in section 2.11.5, you can 
configure the maximum volume for each tube size.

2.10  Turn on Power
The system’s power switch is located just below the touch 
screen panel. 

1. Turn the switch to the ON position. The system will begin 
its startup routine which includes self diagnostics. 

2. Monitor the movement of the fraction collector arm. The 
arm should move to the left rear corner of the fraction 
collector area. You should not hear any grinding noises 
during the homing sequence. If grinding is heard there is a 
problem with the homing of the fraction collector arm.

3. The system is ready for operation when the PeakTrak 
screen is displayed. 
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2.11  Configure the System
Before operating the system, it should be configured for the 
desired operation. To configure the system, open the 
Configuration window by selecting Tools>Configuration from 
the PeakTrak menu.

The configuration window has three tabs: Instrument 
Configuration, Network Configuration, and User Preferences. 
Network Configuration settings are discussed later in 
Section 6, Remote Interfaces.

Adjust the following (sections 2.11.1 through 2.11.6) on the 
Instrument Configuration and User Preferences tabs for the 
desired operation and then click OK to save the settings. 

2.11.1  Solvents

When you installed the system, up to four solvents were 
connected to the back panel. This section of the Instrument 
Configuration tab allows you to manage these solvents. To do 
so:

Note
The system is shipped with common solvent names already 
loaded. If your solvent names are listed in the solvent drop-down 
list boxes, skip steps 1 through 3.

1. Click the “Add Solvent” button.

2. Enter the solvent name and click the OK button.

3. Repeat steps 1 and 2 for all solvents.

4. For the Solvent A1 drop-down list box, select the solvent 
name connected to the A1 Solvent Inlet Port. Repeat for 
Solvents A2, B1, and B2.

5. Select the “Enable solvent level sensing” check box to 
enable this feature (recommended). Clear this box to 
disable this feature.

The solvent level sensing feature will monitor solvent 
usage to minimize the risk of running out of solvent during 
a purification run. The system compares the volume 
required for a purification run with the estimated volume 
in the solvent container and alerts you when there is not 
enough.
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6. If using the solvent level sensing feature, enter the 
Minimum Solvent Level (density dependent) as a range in 
centimeters.

To understand this range, consider that dichloromethane is 
more dense than hexane. If the selected range is 2–4, the 
system triggers an alert when the dichloromethane level 
falls to about 2 cm above the weighted filter. At the same 
selected range, the system would trigger an alert when the 
hexane falls to about 4 cm above the weighted filter.

2.11.2  General Settings

CombiFlash Rf Name (optional) – Use this option to name 
your system. The name will appear in operational displays 
and run summaries. This feature is useful when your 
laboratory has more than one CombiFlash Rf system. 

Time Zone – Select your time zone from the drop-down list 
box.

2.11.3  Set Date/Time

Click this button to open a window from which you can set the 
system date and time. 

To prevent unauthorized time changes, this feature is 
password protected. The system is shipped with the password 
set to combiflash. Use the Tools>Set Password menu 
command to change this password for greater security. 

2.11.4  Vapor Limit

The system has an internal vapor sensor that detects vapors 
present in the immediate atmosphere. When the limit is 
exceeded, the CombiFlash Rf will shut down to avoid a 
hazardous condition.

Teledyne Isco recommends using the default setting of 25. 
This value represents an organic vapor level slightly above the 
ambient vapor level of a well-ventilated laboratory.

A setting below 25 could cause random alarms without 
significant vapors present. If PeakTrak displays a Vapor Limit 
alarm while the Vapor Limit is set at 25, perform the following 
checks on your laboratory and the instrument:

• Ensure that no open containers or spills of organic 
solvent are in close proximity to the system.
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• Ensure that the system is located in a well-ventilated 
area.

• Ensure that there is no visible solvent leakage from the 
system.

If PeakTrak continues to display the Vapor Limit alarm after 
you have made these checks and corrected any problems 
found, it is likely that organic vapors are present in the ambi-
ent environment of your laboratory. In this case, increase the 
setting of the Vapor Limit. Settings greater than 25 are appro-
priate for laboratory environments with a somewhat elevated 
background solvent vapor concentration, representing a safe 
setting, but one with a reduced margin for error.

2.11.5  Set Default Tube Volumes

Click this button to open a window from which you can set the 
default volume of the collection tubes. You can increase or 
decrease these values to set the desired default volume 
collected in each container. Just be sure you don’t overflow the 
containers by exceeding their capacity.

The system will automatically advance to the next tube when 
this default volume is met in each tube. Keep in mind that 
advanced method settings (discussed in Section 5 and the 
on-line help) may override this default setting. During a run, 
other factors such as automatic tube advances for detected 
peaks will affect collected volume.

2.11.6  User Preferences

View the User Preferences tab to configure system operation 
for each user. Select a user from the drop-down list and 
configure the following:

Note
New systems will only have one user account named “common.”

Language – Select the user’s desired language from the 
drop-down list box.

Automatically Print Report at End of Run – if this option 
is enabled, the system will print a report at the end of each 
run. 
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Note
This option requires the system to be configured for network 
operation and a connection to a printer on the network. Network 
settings are discussed in Section 6, Remote Interfaces. Do not 
select this option for these initial installation steps.

Default Run Units – Run units are displayed along the 
X-axis of the chromatogram. Select Time (in minutes) or 
Column Volumes. A column volume unit is the time it takes to 
pump enough solvent to exchange the volume held by the 
column. The duration in minutes will vary according to the 
column media and size, and the flow rate.

Gradient Method – Select the standard gradient type 
(Figure 2-8). 

• Linear – The system gradually mixes solvents A and B 
from the last programmed %B until it reaches the next 
programmed %B. This method connects the inflection 
points that define the gradient with a straight line. 

• Step – The system holds each %B value until it reaches 
the next programmed %B. Because the system holds the 
%B values, the changes at each new value are nearly 
instantaneous, producing a stepped appearance on the 
plot area.

• Isocratic – The system holds the initial solvent mix for 
the entire run. 

Figure 2-8  Gradient types

Enable Run Length Extension – When enabled, this option 
automatically extends the run if a peak is eluting at the end of 
the maximum %B gradient. This ensures that a late-eluting 
peak fully comes off the column and is collected.

An automatic run extension is a five-minute isocratic hold 
added to the end of the run’s maximum %B gradient profile. 

IsocraticStepLinear
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During the extension, the system continues to pump the 
maximum %B solvent mixture. Should the system still detect 
a peak after an extension, the system will add another, up to a 
maximum of three extensions.

Occasionally, compounds might come off the column once the 
%B returns to the minimum value at the end of a run. If the 
Run Length Extension is enabled, it will automatically extend 
the run one time to clear the column and plumbing of any 
remaining material.

Figure 2-9  Automatic Run Extension Examples

Figure 2-9 illustrates the possible run extensions. The original 
method was programmed to rise to the maximum %B over 
seven minutes, hold for two minutes and return to the 
minimum %B for a final minute. At nine minutes, a peak was 
eluting. The system extended the run, holding the %B at the 
maximum level for another five minutes. This also occurred at 
fourteen and nineteen minutes, resulting in the second and 
third extensions. At 24 minutes, the %B solvent strength 
returned to zero. Before the final minute elapsed, more 
compound was detected, causing the system to extend the run 
for a final five minutes at the minimum %B.

Enable rapid equilibration – select this option to 
equilibrate the column at a high flow rate. 

Note
Due to the high pressure that is possible during rapid equilibration, 
this option may not be desirable for some column media or 
purification methods. 

0 5 10 15 20 25

Original method
Extension 1

Extension 2
Extension 3

Final Extension

Minutes
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2.12  Prime the Solvent Lines
Before the first use, the system should be primed. Ensure that 
the solvent containers are filled, then:

1. Select the “Tools>Auto prime” menu command.

2. Select the desired A and B solvents from the drop-down list 
boxes.

3. Click the Play button to start priming the system.

The system pumps 100% Solvent B through the system and 
out the Waste port, and then repeats with 100 % Solvent A. 
(This B-A order leaves the internal lines filled with solvent 
more appropriate for the beginning of a purification run.)

Note
When priming the first time, inspect the solvent and waste 
connections to the system. If any leaks are observed, click the 
Cancel button to stop the Auto Prime. Correct the leak by 
tightening the fitting an additional 1/4 turn, and then restart the Auto 
Prime from step 1.

To advance to the next Auto Prime step, you can click the 
Fast Forward button. The Auto Prime window closes when 
finished.

After Auto Priming, the system is ready for operation 
(Section 5).

Note
Use Auto Prime for quick solvent changes by pumping a fixed 
amount of solvent through the waste fluid path at 100 mL/min. For 
more advanced priming functions such as varying the flow rates, 
fluid paths, etc., or to purge the system with air before changing 
between normal and reversed phase solvent systems, use the 
Tools>Manual Control option.
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2.13  System Verification
It is recommended that the system operation be verified. To do 
so, use a pre-packaged CombiFlash Rf test kit: 

• Part number 60-5237-050
Test kit containing five of the 5 gram size solid load 
cartridges pre-filled with 0.5 grams of test sample 
NPHE, and five 4 gram RediSep Rf silica gel columns.

• Part number 60-5237-051
Test kit containing four of the 25 gram size solid load 
cartridges pre-filled with 0.5 grams of test sample 
NPHE, and four 4 gram RediSep Rf silica gel columns.

The test kits include instructions. 
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2.14  Installation Qualification Checklist

Table 2-1 Installation Qualification Checklist

Step Description
Installer 
Initials

Operator 
Initials

2.1 Unpacking the Unit

2.2 Instrument Location

2.3 Connect Power

2.4 Connect Solvent Lines

2.5 Connect Waste Lines

2.6 Optional External Gas

2.7 Connect and Route Drain Lines

2.8 Position the System

2.9 Install Collection Tube Racks

2.10 Turn on Power

2.11 Configure the System

2.12 Prime the Solvent Lines

2.13 System Verification

Certification of Section 2 Completion

Installer Name (print):

Installer Signature:

Date:

Operator Name (print):

Operator Signature:

Date:

Comments:
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CombiFlash® Rf
Installation Guide

Section 3 Preparation:
Rf 75 Systems

This section provides instructions for unpacking and installing 
the CombiFlash Rf 75 system. To prepare the system for 
operation, sequentially follow all instructions in sections 3.1 
through 3.11.

Note
Section 3.13 contains an Installation Qualification checklist. If 
required, sign off the checklist entries as you successfully 
complete the following sections.

3.1  Unpacking the Unit
The CombiFlash Rf 75 system is shipped in a single carton. 
Carefully unpack the shipment and inspect the contents. 

WARNING
The system is heavy. Use a two-person lift to prevent injury.

CAUTION
Do not lift the system by the fraction collector arm. Use the lifting 
handles located on the instrument side panels. 

If there is any damage to the shipping carton or any 
components, contact the shipping agent and Teledyne Isco (or 
its authorized representative) immediately.

WARNING
If there is any evidence that the system has been damaged in 
shipping, do not plug it into AC power. Contact Teledyne Isco 
or its authorized representative for advice.
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Compare the contents of the box with the enclosed packing 
slips. If there are any shortages, contact Teledyne Isco 
immediately.

The fraction collector arm was stowed to prevent damage 
during shipping. The arm stowing bracket should be removed 
at this time. 

1. Loosen the bracket’s two thumbscrews along the sides of 
the arm (Figure 3-1).

Figure 3-1  Remove arm stowing bracket and spacer

2. Push the arm to the left or right remove the spacer. 

3. Store the bracket and spacer. These parts should be 
reinstalled if the system needs to be shipped again. 

3.2  Instrument Location
The CombiFlash Rf 75 has a relatively small footprint, 
requiring about 1550 square centimeters (240 in2) of level 
bench space. Ensure that the CombiFlash Rf has at least 3 cm 
(1.25") of air space behind it for ventilation. Additional space 
may be required for solvent and waste containers. 

Refer to Table 1-1 of this guide for environmental conditions 
and power requirements. 

WARNING
The system is heavy. Use a two-person lift to prevent injury.

Spacer

Thumbscrew

Thumbscrew
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Before making any connections to the CombiFlash Rf 75, place 
the system on the bench or in the fume hood where it will be 
operated. Temporarily position the system so you can access 
the back panels to complete the connections.

3.3  Connect Power
Ensure that the On/Standby switch below the touch screen 
panel is in the Standby position. Then, use the supplied IEC 
power cord to connect the CombiFlash Rf to mains power.

WARNING
Mains power must meet the voltage, frequency, and amperage 
requirements listed on the serial number label.

WARNING
As long as the AC mains power cord is connected, power is 
inside the unit. The mains power cord is the disconnect device. 
Position the Rf 75 system so that the power cord can be 
unplugged, or use a power strip where the plug can quickly be 
removed from the outlet in the event of an emergency. 

3.4  Connect Solvent Lines

WARNING
Risk of fire ignited by electrostatic discharge. Never substitute 
the black tubing on CombiFlash systems. The black tubing 
(P/N 023-0503-06) is conductive. This tubing is required to 
dissipate static electricity.

CAUTION
To prevent damage or premature wear to the pump and internal 
valves, clean solvent should be used. The solvent should not 
contain any dissolved solids.
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Figure 3-2  CombiFlash Rf 75 solvent inlet ports

The CombiFlash Rf 75 system has two solvent inlet ports on 
the back panel: one A solvent and one B solvent (Figure 3-2). 

The system requires at least one A and one B solvent to form a 
binary gradient. It assumes that the B solvent is stronger than 
A. When using the optional valve kit. the second set of inputs 
allows you to manually switch between alternative binary 
gradient solvent systems, or to change the B solvent mid-run. 

Note
An optional, manual solvent selection valve kit may be added to 
provide inlets for two A solvents and two B solvents. If using the 
optional valve kit, connect the kit and solvent lines according to 
the instruction sheet.

Accessory package P/N 60-5239-009 includes pieces to 
complete the solvent inlet connections.

1. Locate a Solvent Inlet Filter Assembly (P/N 60-5234-193) 
in the accessory package. Connect the tubing end to the A 
Solvent inlet. Thread the nut into the Solvent A Inlet and 
finger-tighten.

2. Connect the second Solvent Inlet Filter assembly to the B 
Solvent inlet.

3. Insert the filter end of each solvent inlet filter assembly 
into their respective solvent containers.

Solvent Inlet Ports
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4. The accessory package includes labels to easily identify the 
inlet lines. Apply the A and B labels to the solvent lines 
above the solvent container openings. 

Note
When using higher-density solvents such as dichloromethane 
(DCM), place the solvent container level with or above the 
CombiFlash Rf system. Placing solvent containers below the level 
of the system can contribute to decreased flow due to the high 
vapor pressure of DCM. This problem becomes more pronounced 
as the ambient temperature increases.

3.5  Connect Waste Lines

WARNING
Risk of fire or equipment damage. Failure to connect Waste 
Port tubing may allow organic solvents to pool in unsafe areas, 
possibly creating dangerous levels of flammable vapors.

WARNING
Risk of fire ignited by electrostatic discharges. Never 
substitute the black tubing on CombiFlash systems. The black 
tubing (P/N 023-0503-06) is conductive. This tubing is required 
to dissipate static electricity.

CAUTION
Elevated flammable vapor levels are possible. Ensure that the 
waste container is adequately ventilated, preferably by placing it in 
a fume hood. 

CAUTION
Do not overfill the waste collection containers. Regularly monitor 
and empty the bottles before they overfill. 

The system has one waste outlet on the back panel: Diverter 
Valve waste. 

Accessory package (P/N 60-5239-009) includes a Waste Tube 
Assembly (P/N 60-5234-187). To connect the Waste tube: 
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1. Connect the cut end of this assembly to the Diverter Valve 
Waste port on the system: 

a. locate the black nut and ferrule in the accessory 
package. Slide the nut and ferrule onto the tubing as 
shown in Figure 3-3.

Figure 3-3  Preparing a bulkhead fitting connection

b. Fully insert the tubing into the threaded bulkhead 
fitting on the back panel of the system.

c. Finger-tighten the nut onto the threaded bulkhead 
fitting. This will seat the ferrule in the fitting.

2. Route the tubing and insert the weighted end into the 
user-supplied waste container.

3.6  Connect and Route Drain Lines

WARNING
Risk of fire or equipment damage. Failure to connect drain lines 
may allow organic solvents to pool in unsafe areas, creating a 
potential for dangerous levels of flammable vapors. Improper 
draining may damage the instrument’s internal components.

The CombiFlash Rf 75 system has drain tubes extending from 
its top shelf and back panel. The tubes drain away any liquid 
spilled on the top shelf and the tray beneath the fraction 
collection racks.

1. Test the fraction collector drain by connecting a vacuum or 
air supply source to the outlet end of the drain tube. Then, 
verify the presence of such vacuum or air supply source on 
the drain (Figure 3-4).

2. Test the top shelf drain by connecting a vacuum or air 
supply source to the outlet end of the drain tube. Then, 
verify the presence of such vacuum or air supply source on 
the drain (Figure 3-5).

Ferrule

Nut

Tubing
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Figure 3-4  Fraction Collector Drain

Figure 3-5  Top Shelf Drain

Vacuum or 
pressurized air 
applied to the outlet 
end of the drain 
tube must exist at 
the collection tray 
drain hole.

Vacuum or 
pressurized air 
applied to the outlet 
end of the drain 
tube must exist at 
the top shelf drain 
hole.
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3. Route the end of both drain tubes to a suitable waste fluid 
collection container.

Note
It may be necessary to extend the drain tube. If so, splice the 
tubing with user-supplied tubing. The user-supplied tubing should 
have an inside diameter no smaller than the existing drain tubing, 
and must be compatible with the solvents used by the system. 
Route this extension tubing to the waste collection vessel.

3.7  Position the System
After completing the various connections, the system can be 
moved to its operating position. Turn the system so that the 
operator can access all of the front view features and controls 
(Figure 1-4). Use care not to damage the connections, tubing, 
and cables while moving the system.

CAUTION
Ensure that the CombiFlash Rf has at least 3 cm (1.25") of air 
space behind it for ventilation. 

Position the solvent and waste containers as necessary. 

Note
When using higher-density solvents such as dichloromethane 
(DCM), place the solvent container level with or above the 
CombiFlash Rf system. Placing solvent containers below the level 
of the Rf can contribute to decreased flow due to the high vapor 
pressure of DCM. This problem becomes more pronounced as the 
ambient temperature increases.

3.8  Install Collection Tube Racks
Before beginning a run, you must load collection racks with 
tubes onto the system’s fraction collector tray. 

Your system was shipped with two collection tube racks. The 
following tube rack sets are available:

• 60-5237-013 – Two racks for 13×100 mm test tubes 
(8 mL). Total tubes: 216.

• 60-5237-031 – Two racks for 16×125 mm test tubes 
(15.5 mL). Total tubes: 150.
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• 60-5237-032 – Two racks for 16×150/160 mm test 
tubes (18 mL). Total tubes: 150.

• 60-5237-033 – Two racks for 18×150 mm test tubes 
(25 mL). Total tubes: 140.

• 60-5237-034 – Two racks for 18×180 mm test tubes 
(30 mL). Total tubes: 140.

• 60-5237-035 – Two racks for 25×150 mm vials 
(50 mL). Total vials: 60.

• 60-5237-040 – One rack for 480 mL French square 
bottles.

• 60-5394-469 – Two racks for 28×61 mm scintillation 
vials (20 mL). Total vials: 54.

• 60-5394-468 – Two racks for 28×95 mm scintillation 
vials (40 mL). Total vials: 60.

To load the racks:

1. Insert test tubes, vials, or bottles into the rack (Fig. 3-6).

CAUTION
Risk of broken glass or equipment damage. Do not load test tubes 
longer than the length listed on the rack label.

2. While holding the rack with the rack label visible (Figure 
3-7), insert the racks into the system. Slide the rack in 
until you feel it drop into its seated position. 

CAUTION
An incorrectly installed rack will cause the rack to be misaligned 
under the fraction collector arm. Misaligned racks might cause 
fractions to miss the tube opening or deposit in the wrong tube. 
Always ensure the tube size label is visible (that is, facing 
outward) and the rack is pushed in until it is seated.

When you turn the power switch to on, the system will 
automatically detect the type of rack, and configure program 
settings accordingly. Later, in section 3.10.4, you can 
configure the maximum volume for each tube size.
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Figure 3-6  Loading test tubes

Figure 3-7  Inserting the collection tube rack

Rack 
Label
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3.9  Turn on Power
The system’s power switch is located just below the touch 
screen panel. 

1. Turn the switch to the ON position. The system will begin 
its startup routine which includes self diagnostics. 

2. Monitor the movement of the fraction collector arm. The 
arm should move to the left rear corner of the fraction 
collector area. 

CAUTION
You should not hear any grinding noises during the homing 
sequence. If grinding is heard there is a problem with the homing 
of the fraction collector arm. Contact the factory for assistance. 

3. The system is ready for operation when the PeakTrak 
screen is displayed. 

3.10  Configure the System
Before operating the system, it should be configured for the 
desired operation. To configure the system, open the 
Configuration window by selecting Tools>Configuration from 
the PeakTrak menu.

The configuration window has two tabs: Instrument 
Configuration and Network Configuration. Network 
Configuration settings are discussed later in Section 6, Remote 
Interfaces.

Adjust the following (sections 3.10.1 through 3.10.10) on the 
Instrument Configuration tab for the desired operation and 
then click OK to save the settings. 

3.10.1  Solvents

When you installed the system, up to two solvents were 
connected to the back panel. This section of the Instrument 
Configuration tab allows you to name these solvents. To do so:

Note
The system is shipped with common solvent names already 
loaded. If your solvent names are listed in the solvent drop-down 
list boxes on the main window, skip these steps.



CombiFlash® Rf Installation Guide

3-12

1. Click the “Add Solvent” button.

2. Enter the solvent name and click the OK button.

3. Repeat steps 1 and 2 for both solvents.

3.10.2  General Settings

CombiFlash Rf Name (optional) – Use this option to name 
your system. The name will appear in operational displays 
and run summaries. This feature is useful when your 
laboratory has more than one CombiFlash Rf system. 

Time Zone – Select your time zone from the drop-down list 
box.

Language – Select the user’s desired language from the 
drop-down list box.

3.10.3  Set Date/Time

Click this button to open a window from which you can set the 
system date and time. 

To prevent unauthorized time changes, this feature is 
password protected. The system is shipped with the password 
set to combiflash. Use the Tools>Set Password menu 
command to change this password for greater security. 

3.10.4  Set Default Tube Volumes

Click this button to open a window from which you can set the 
default volume of the collection tubes. You can increase or 
decrease these values to set the desired default volume 
collected in each container. Just be sure you don’t overflow the 
containers by exceeding their capacity.

The system will automatically advance to the next tube when 
this default volume is met in each tube. Keep in mind that 
advanced method settings (discussed in Section 5 and the 
on-line help) may override this default setting. During a run, 
other factors such as automatic tube advances for detected 
peaks will affect collected volume.

3.10.5  Automatically Print Report at End of Run

If this option is enabled, the system will print a report at the 
end of each run.
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Note
This option requires the system to be configured for network 
operation and a connection to a printer on the network. Network 
settings are discussed in Section 6, Remote Interfaces. Do not 
select this option for these initial installation steps.

3.10.6  Default Run Units

Run units are displayed along the X-axis of the chromatogram. 
Select Time (in minutes) or Column Volumes. A column 
volume unit is the time it takes to pump enough solvent to 
exchange the volume held by the column. The duration in 
minutes will vary according to the column media and size, and 
the flow rate.

Gradient Method – Select the standard gradient type 
(Figure 3-8). 

• Linear – The system gradually mixes solvents A and B 
from the last programmed %B until it reaches the next 
programmed %B. This method connects the inflection 
points that define the gradient with a straight line. 

• Step – The system holds each %B value until it reaches 
the next programmed %B. Because the system holds the 
%B values, the changes at each new value are nearly 
instantaneous, producing a stepped appearance on the 
plot area.

• Isocratic – The system holds the initial solvent mix for 
the entire run. 

Figure 3-8  Gradient types

3.10.7  Vapor Limit

The system has an internal vapor sensor that detects vapors 
present in the immediate atmosphere. When the limit is 
exceeded, the CombiFlash Rf will shut down to avoid a 
hazardous condition.

IsocraticStepLinear
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Teledyne Isco recommends using the default setting of 25. 
This value represents an organic vapor level slightly above the 
ambient vapor level of a well-ventilated laboratory.

A setting below 25 could cause random alarms without 
significant vapors present. If PeakTrak displays a Vapor Limit 
alarm while the Vapor Limit is set at 25, perform the following 
checks on your laboratory and the instrument:

• Ensure that no open containers or spills of organic 
solvent are in close proximity to the system.

• Ensure that the system is located in a well-ventilated 
area.

• Ensure that there is no visible solvent leakage from the 
system.

If PeakTrak continues to display the Vapor Limit alarm after 
you have made these checks and corrected any problems 
found, it is likely that organic vapors are present in the ambi-
ent environment of your laboratory. In this case, increase the 
setting of the Vapor Limit. Settings greater than 25 are appro-
priate for laboratory environments with a somewhat elevated 
background solvent vapor concentration, representing a safe 
setting, but one with a reduced margin for error.

3.10.8  Enable Run Length Extension

When enabled, this option automatically extends the run if a 
peak is eluting at the end of the maximum %B gradient. This 
ensures that a late-eluting peak fully comes off the column 
and is collected.

An automatic run extension is a five-minute isocratic hold 
added to the end of the run’s maximum %B gradient profile. 
During the extension, the system continues to pump the 
maximum %B solvent mixture. Should the system still detect 
a peak after an extension, the system will add another, up to a 
maximum of three extensions.

Occasionally, compounds might come off the column once the 
%B returns to the minimum value at the end of a run. If the 
Run Length Extension is enabled, it will automatically extend 
the run one time to clear the column and plumbing of any 
remaining material.
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Figure 3-9  Automatic Run Extension Examples

Figure 3-9 illustrates the possible run extensions. The original 
method was programmed to rise to the maximum %B over 
seven minutes, hold for two minutes and return to the 
minimum %B for a final minute. At nine minutes, a peak was 
eluting. The system extended the run, holding the %B at the 
maximum level for another five minutes. This also occurred at 
fourteen and nineteen minutes, resulting in the second and 
third extensions. At 24 minutes, the %B solvent strength 
returned to zero. Before the final minute elapsed, more 
compound was detected, causing the system to extend the run 
for a final five minutes at the minimum %B.

3.10.9  Enable rapid equilibration

Select this option to equilibrate the column at a high flow rate. 

Note
Rapid equilibration may not be desirable for some column media 
or purification methods. 

3.10.10  Optional Features

Click this button to open a window from which you can enter 
activation codes that turn on optional features. Teledyne Isco 
provides activation codes on certificates that are issued after 
the option is purchased. 

3.11  Prime the Solvent Lines
Before the first use, the system should be primed. Ensure that 
the solvent containers are filled, then:

0 5 10 15 20 25

Original method
Extension 1

Extension 2
Extension 3

Final Extension

Minutes
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1. Select the “Tools>Auto prime” menu command.

2. Click the Play button to start priming the system.

The system pumps 100% Solvent B through the system and 
out the Waste port, and then repeats with 100 % Solvent A. 
(This B-A order leaves the internal lines filled with solvent 
appropriate for the beginning of a purification run.)

Note
When priming the first time, inspect the solvent and waste 
connections to the system. If any leaks are observed, click the 
Cancel button to stop the Auto Prime. Correct the leak by 
tightening the fitting an additional 1/4 turn, and then restart the Auto 
Prime from step 1.

To advance to the next Auto Prime step, you can click the 
Fast Forward button. The Auto Prime window closes when 
finished.

After Auto Priming, the system is ready for operation 
(Section 5).

Use the Auto Prime feature for quick solvent changes by 
pumping a fixed amount of solvent through the waste fluid 
path at a high flow rate. For more advanced priming functions 
such as varying the flow rates, fluid paths, etc., use the 
Tools>Manual Control option.

3.12  System Verification
It is recommended that the system operation be verified. To do 
so, use a pre-packaged CombiFlash Rf test kit: 

• Part number 60-5237-050
Test kit containing five of the 5 gram size solid load 
cartridges pre-filled with 0.5 grams of test sample 
NPHE, and five 4 gram RediSep Rf silica gel columns.

• Part number 60-5237-051
Test kit containing four of the 25 gram size solid load 
cartridges pre-filled with 0.5 grams of test sample 
NPHE, and four 4 gram RediSep Rf silica gel columns.

The test kits include instructions. 
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3.13  Installation Qualification Checklist

Table 3-1 Installation Qualification Checklist

Step Description
Installer 
Initials

Operator 
Initials

3.1 Unpacking the Unit

3.2 Instrument Location

3.3 Connect Power

3.4 Connect Solvent Lines

3.5 Connect Waste Lines

3.6 Connect and Route Drain Lines

3.7 Position the System

3.8 Install Collection Tube Racks

3.9 Turn on Power

3.10 Configure the System

3.11 Prime the Solvent Lines

3.12 System Verification

Certification of Section 3 Completion

Installer Name (print):

Installer Signature:

Date:

Operator Name (print):

Operator Signature:

Date:

Comments:
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CombiFlash® Rf
Installation Guide

Section 4 Preparation:
Optional 4x Module

This section provides instructions for unpacking and installing 
the CombiFlash Rf 4x module after completing the 
CombiFlash Rf 200 system installation (Section 2). To prepare 
the system for operation, sequentially follow all instructions in 
sections 4.1 through 4.10.

Note
Section 4.12 contains an Installation Qualification checklist. If 
required, sign off the checklist entries as you successfully 
complete the following sections.

4.1  Unpacking the Unit
The CombiFlash Rf 4x module is shipped in a single carton. 
Carefully unpack the shipment and inspect the contents. If 
there is any damage to the shipping carton or any components, 
contact the shipping agent and Teledyne Isco (or its 
authorized representative) immediately.

WARNING
If there is any evidence that the system has been damaged in 
shipping, do not plug it into AC power. Contact Teledyne Isco 
or its authorized representative for advice.

Compare the contents of the boxes with the enclosed packing 
slips. If there are any shortages, contact Teledyne Isco 
immediately.

4.2  Instrument Location
The CombiFlash Rf has a relatively small footprint, requiring 
about 1550 square centimeters (240 in2) of level bench space. 
Ensure that the CombiFlash Rf has at least 3 cm (1.25") of air 
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space behind it for ventilation. Additional space may be 
required for solvent and waste containers. 

The optional 4x expansion module is installed to the left of the 
CombiFlash Rf. This module requires an additional 933 cm2 
(145 in2) of level bench space. Ensure that the module has at 
least 3 cm (1.25") of air space behind it for ventilation. 

Refer to Table 1-2 for environmental conditions and power 
requirements. 

Before making any connections to the CombiFlash Rf 4x 
module, place it on the bench or in the fume hood where it will 
be operated. Temporarily position the system so you can 
access the back panels to complete the connections.

4.3  Connect Power
Ensure that the On/Standby switch below the Rf system touch 
screen panel is in the Standby position. Then, use the supplied 
IEC power cord to connect the CombiFlash Rf 4x module to 
mains power.

WARNING
Mains power must meet the voltage, frequency, and amperage 
requirements listed on the serial number label.

WARNING
As long as the AC mains power cord is connected, power is 
inside the unit. The mains power cord is the disconnect device. 
Position the Rf 200 system and Rf 4x module so that the power 
cord can be unplugged, or use a power strip where the plug 
can quickly be removed from the outlet in the event of an 
emergency. 

4.4  Connect Solvent Lines

WARNING
Risk of fire ignited by electrostatic discharge. Never substitute 
the black tubing on CombiFlash systems. The black tubing 
(P/N 023-0503-06) is conductive. This tubing is required to 
dissipate static electricity.
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CAUTION
To prevent damage or premature wear to the pump and internal 
valves, clean solvent should be used. The solvent should not 
contain any dissolved solids.

The CombiFlash Rf 200 system has four solvent ports on the 
left side panel. To complete the solvent connections:

1. Locate the ABCD label in accessory package 69-5234-008. 
Affix this label to the Rf 200 left side panel, just above the 
solvent ports (Figure 4-1). 

Figure 4-1  Labeled ports on Rf 200 side panel

2. Remove the jumpers tubing from ports A, B, C, and D. 

3. Locate the solvent lines on the side of the Rf 4x module. 
These lines are labeled A through D. Connect the solvent 
lines to their respective ports on the Rf system. 

4.5  Connect Waste Lines

WARNING
Risk of fire or equipment damage. Failure to connect Waste 
Port tubing may allow organic solvents to pool in unsafe areas, 
possibly creating dangerous levels of flammable vapors.

Front
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WARNING
Risk of fire ignited by electrostatic discharges. Never 
substitute the black tubing on CombiFlash systems. The black 
tubing (P/N 023-0503-06) is conductive. This tubing is required 
to dissipate static electricity.

CAUTION
Elevated flammable vapor levels are possible. Ensure that the 
waste container is adequately ventilated, preferably by placing it in 
a fume hood. 

The Rf 4x module has six liquid waste ports on the back panel: 

• one inlet to receive diverter valve waste from the Rf 
system labeled Column Waste, From RF. 

• four waste outlets —one for each column channel, 
labeled Column Waste 1, 2, 3, and 4. 

• one Valve Waste outlet shared by channels 2 through 4 
for automatic injection valve cleaning. 

Figure 4-2  4x Module back panel connections
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The Rf 4x module can automatically detect full waste bottles 
and stop operation to prevent overfilling a waste container. 
This safety feature requires five air line connections:

• one Waste Level Sense From RF inlet to receive air or 
external gas from the Rf system 

• four Waste Level Sense outlets 1, 2, 3, and 4. 

Note
The following instructions assume that the waste from each 
channel will be isolated in separate containers. 

Note
If the waste is to be collected in a common container, skip the 
Column Waste and Waste Level Sense connections (steps 1 
through 6) and complete step 7 below to route the Valve Waste 
Out from the Rf 4x module. The waste tubing assembly connected 
to the back panel of the Rf 200 system will route all waste fluids to 
the common collection container and sense the level. 

To complete the waste line connections:

1. At the waste container cap for the Rf 200 system (Channel 
1), remove the black tubing that delivers Diverter Valve 
Waste fluids and the natural tubing that delivers Waste 
Level Sense air.

2. At the Rf 200 system back panel, disconnect the black 
tubing from the Diverter Valve Waste port and the natural 
tubing from the Waste Level Sense port. 

Note
The Inject Valve Waste tubing must remain connected between 
the Rf system back panel and its waste container. 

3. Locate the 20 inch (50 cm) length of black tubing from 
accessory package 60-5239-008. Connect this tubing 
between the Rf 200 system and the Rf 4x module:

a. Connect the cut end of the black tubing to the Rf 200 
system Diverter Valve Waste port. Use a black nut and 
ferrule from the accessory package as shown in Figure 
4-3. Finger-tighten the nut to seat the ferrule in the 
bulkhead fitting. 
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Figure 4-3  Preparing a bulkhead fitting connection

b. Connect the other end of the black tubing to the Rf 4x 
port labeled “From Rf” (in the block labeled “Column 
Waste”). Finger-tighten the attached nut to seal the 
fitting. 

4. Locate the 20 inch (50 cm) length of natural tubing from 
the accessory package. Using nuts and ferrules for the 
black bulkhead fittings, connect this tubing between the Rf 
200 system’s Level Sense port and the Rf 4x module’s 
Waste Level Sense From Rf port. 

5. Select one of the three waste line assemblies from the 
accessory package. This will be used to complete the waste 
connections for channel 1. 

Note
These instructions assume that the waste from each channel will 
be isolated in separate containers. If the waste is to be collected in 
a common container, the waste can be routed 

Note
omit the use of the waste caps and secure all liquid and air lines in 
the common container. The ends of all air lines should extend at 
least 2 inches (5 cm) below the container opening. 

a. At the Rf 4x back panel, connect the nut on the waste 
line assembly to the Column Waste port labeled “1.” 

b. Connect the natural tubing of the waste line assembly 
to the Waste Level Sense port labeled “1.”

Ferrule

Nut

Tubing
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Figure 4-4  Recommended Rf 4x module waste connections

60-0923-017 Ferrule

60-0923-015
Compression Fitting

Nut

60-5234-188
Waste Line Assembly

60-5235-053 38 mm Waste Cap, or
60-5235-054 45 mm Waste Cap

To Rf 4x module 
Column Waste connections 
1, 2, 3, or 4To Waste Level

Sense Connection

To Rf 200 system 
Inject Valve Waste 
(Channel 1)

To Rf 4x module 
Valve Waste Out 
(Channels 2, 3, and 4, 
summed). Route to solvent 
bottle of choice.

Tubing Stop

Ventilation Hole
(Luer fitting)
If necessary, connect 
user-supplied tubing and 
route to fume hood. 

(See Top View)

(Top View)

Column Waste

 Waste Level Sense

Inject Valve Waste (Rf 200)
or Valve Waste Out (Rf 4x)

Ventilation 
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c. At the waste container cap for channel 1 insert the 
black tubing into the Diverter Valve Waste opening and 
the natural tubing into the Waste Level Sense opening 
(Figure 4-4). Push the stop on the Waste Level Sense 
tubing against the cap. This ensures that the Waste 
Level Sense tubing is far enough into the container to 
detect when it is nearly full.

6. Using the three remaining waste line assemblies and 
waste caps, complete the waste connections for channels 2 
through 4. (See Figure 4-4.)

7. The post-run valve cleaning fluids share a common port for 
channels 2 through 4. Select the 48 inch (120 cm) length of 
black tubing from the accessory package and connect it to 
the Valve Waste Out bulkhead fitting on the Rf 4x module. 
Route the other end of this tubing to one of the waste 
bottles. You can alternatively route it to another container, 
however the system will not be able to detect the level and 
prevent overfilling. 

Note
When using higher-density solvents such as dichloromethane 
(DCM), ensure that waste containers are no more than 3 feet 
below the supply solvent levels. Placing solvent containers above 
the system and waste containers on the floor may cause the 
internal check valves to open and allow solvent to flow through the 
system when in the standby state.

Note
The back panel ports labeled A and B are not used. 

4.6  Control Connection
Operation of the Rf 4x module is controlled by the Rf 200 
system via a USB connection. Connect the USB cable from the 
Rf 4x module to USB port on the Rf 200 system back panel. 
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4.7  Position the System
After completing the fluid, air, and control connections, the 
system can be moved to its operating position. 

CAUTION
Use care not to damage the connections, tubing, and cables while 
moving the system.

1. Turn the Rf 200 system so that the operator can access all 
of the front view features and controls (Figure 1-4).

2. Position the Rf 4x module along the left side of the Rf 200 
system. 

3. The Rf 4x module has a tab extending from the right side of 
its base plate. Slightly raise the Rf 200 system and slide 
the Rf 4x module so that the Rf 200 system will rest on the 
module’s tab. The weight of the Rf 200 on the tab will hold 
the two together. 

4.8  Remove Shipping Hardware
To prevent damage to the injection valve assemblies during 
shipping, each is secured by a thumbscrew which must be 
removed before operating the system. Firmly grasp the 
cartridge guide above the injection valve and then remove the 
thumbscrew (Figure 4-5). Gently lower the injection valve once 
the thumbscrew is removed. 

Note
Save the thumbscrews should there be a need again to stow the 
valves for shipping. 
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Figure 4-5  Remove thumbscrews

Thumbscrew 
(one of three)
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4.9  Turn on Power
Turn the Rf 200 system switch to the ON position. The system 
will begin its startup routine which includes self diagnostics. 
During the startup routine, the Rf 200 will detect the 
connected Rf 4x module and automatically configure the user 
interface to access the additional channels. The system is 
ready for operation when the PeakTrak screen is displayed. 

4.10  Prime the Solvent Lines
The Rf 4x module was factory tested with 1:1 water/isopropyl 
alcohol and subsequently purged with air. If residual fluids 
would affect your chromatography, prime all channels on the 
system. 

Channel 1 should have been primed during the installation 
steps in Section 2.12 (page 2-19). Channel 1 can be primed 
using the Auto Prime menu command. 

Channels 2 through 4 must be primed using the Manual 
Control menu command. To do so:

1. Ensure that the solvent containers are filled.

2. Insert a priming tube assembly (from the accessory 
package) between the upper and lower column mounts on 
channels 2 through 4.

3. Select the “Tools>Manual Control” menu command.

4. Select the Column 2 the channel option.

5. Click the Prime B button. The system pumps 100% solvent 
B through channel 2. 

Note
When priming the first time, inspect the solvent and waste 
connections to the system. If any leaks are observed, click the 
Cancel button to stop the pump. Correct the leak by tightening the 
fitting an additional 1/4 turn, and then restart the prime.

6. Allow the system to pump solvent B for at least 3 minutes. 
Then, click the Cancel button.

7. Click the Prime A button. The system pumps 100% solvent 
A through channel 2. 
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8. Allow the system to pump solvent A for at least 3 minutes. 
Then, click the Cancel button.

Note
This B-A order leaves the internal lines filled with solvent 
appropriate for the beginning of a purification run.

9. Repeat steps 4 through 8 for channels 3 and 4. Be sure to 
change the channel option before starting the pumps. 

4.11  System Verification
It is recommended that the system operation be verified for 
each channel. To do so, use a pre-packaged CombiFlash Rf test 
kit: 

• Part number 60-5237-050
Test kit containing five of the 5 gram size solid load 
cartridges pre-filled with 0.5 grams of test sample 
NPHE, and five 4 gram RediSep Rf silica gel columns.

• Part number 60-5237-051
Test kit containing four of the 25 gram size solid load 
cartridges pre-filled with 0.5 grams of test sample 
NPHE, and four 4 gram RediSep Rf silica gel columns.

The test kits include instructions. 
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4.12  Installation Qualification Checklist

Table 4-1 Installation Qualification Checklist

Step Description
Installer 
Initials

Operator 
Initials

4.1 Unpacking the Unit

4.2 Instrument Location

4.3 Connect Power

4.4 Connect Solvent Lines

4.5 Connect Waste Lines

4.6 Control Connection

4.7 Position the System

4.8 Remove Shipping Hardware

4.9 Turn on Power

4.10 Prime the Solvent Lines

4.11 System Verification

Certification of Section 4 Completion

Installer Name (print):

Installer Signature:

Date:

Operator Name (print):

Operator Signature:

Date:

Comments:
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Section 5 Operation

This section provides abbreviated operating instructions for 
the CombiFlash Rf systems. For complete instructions, refer 
to Help menu option from PeakTrak’s main menu.

5.1  Sample Preparation
Before starting a run, consider how the sample will be 
introduced to the column media. This section discusses three 
methods: liquid injection, solid sample cartridges, and 
preloading the sample on the column. 

5.1.1  Liquid Sample Injection

If the sample is soluble in the starting mobile phase, it can be 
prepared as a solution and injected onto the column when 
prompted during the purification run. 

5.1.2  Solid Samples

Some compounds are not soluble in solvents that are 
compatible with the chromatography. In addition, the 
compounds may have very limited solubility in any solvent, 
resulting in sample volumes that are impractical for good 
chromatography. The answer in this case is solid sample 
introduction. Here the reaction mixture or dissolved sample is 
mixed with the same media in the chromatography column. 

Some samples of this type may be simply dissolved and placed 
into a prefilled cartridge. You can then use the cartridge 
immediately or dry it before placing it on the system. 

Other samples may need more care. Typically you would 
create a mixture of 20% sample load to media (w/w). Then dry 
the mixture under conditions that will drive off the solvent 
without affecting the compounds of interest. These compounds 
remain bound to the media. Once dried, pour the 
media/sample mixture into an empty cartridge.
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To prepare an empty solid sample cartridge:

1. Ensure the empty cartridge has a bottom frit.

CAUTION
Missing frits may cause equipment damage, UV detection 
problems, or increased maintenance. Frits prevent solids from 
entering the fluid path.

2. Prepare the media and sample:

a. Dissolve your sample in a minimal amount of a suitable, 
volatile solvent.

b. Place the media into the solvent. If using silica gel, a 
particle size of 40–60 µm (240–400 mesh) is 
recommended. The amount of silica required is about 
four to five times the mass of your sample.

c. Agitate the solvent for a moment to allow the sample to 
adsorb to the silica.

d. Remove the solvent with a suitable method, such as 
rotary evaporation. Alternatively, you can dry the 
prepared cartridge after step 5 by drawing the solvent 
out using a vacuum or using the Rf 200 system’s air 
purge. 

3. Load the media and sample mixture into the cartridge. Tap 
the cartridge on the benchtop to settle the mixture.

4. Place a frit on the top of the cartridge. Force the frit down 
against the mixture using the plastic plunger.

5. Wipe any residual powder inside the neck of the cartridge.

Note
On Rf 200 and Rf 4x systems, you can remove solvent from a 
prepared cartridge by attaching the cartridge cap and manually 
purging (TOOLS>MANUAL CONTROL) the cartridge with air. 

Empty solid sample cartridges also allow a variety of 
adsorbents, such as diatomaceous earth, boiling chips, cotton 
balls, or paper wipes. Even with alternative adsorbents, 
always use top and bottom frits to prevent fluid path 
problems.
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After you have prepared the pre-filled or empty cartridge, 
place the solid sample cartridge on the system:

1. Attach the desired adjustable cartridge cap:

• 60-5237-047, fits 2.5 and 5 gram solid load cartridges. 

• 60-5237-048, fits 12 and 20 gram solid load 
cartridges. 

• 60-5237-044, fits 32 and 65 gram solid load 
cartridges. 

2. Press the lever on the side of the cap and fully extend the 
plunger (Figure 5-1). 

Figure 5-1  Press the lever and extend the plunger

3. Slide the plunger into the cartridge until it reaches the top 
frit (Figure 5-2).

4. Press the lever and push the cartridge into the cap. Align 
the cartridge so that it fits fully into the recess in the cap 
(Figure 5-3).

5. Load the solid sample cartridge with cap on the sample 
injection port.

Note
Earlier CombiFlash Rf solid load cartridge caps required the use of 
sleeves. Contact the factory for information on upgrading these 
older systems to use the new cartridges without sleeves. 

1

2
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Figure 5-2  Insert the plunger to the bed

Figure 5-3  Align and push cartridge into the cap, and then rotate the 
cartridge to secure it. 

5.1.3  Preloading on Column

You can load the reaction mixture or sample directly onto the 
column, sometimes called “direct” or “dry” loading. 

1

2
3
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Note
If using this method, use care to ensure that a column equilibration 
does not wash away the sample. Bypass the column equilibration 
at run time by selecting “Preload on column” (or “No Equilibration” 
for Rf 75 systems) as the sample Loading Type. Refer to Section 
5.3 for more details. 

5.2  Loading a RediSep Rf Column
To load a RediSep Rf column:

WARNING
The CombiFlash Rf has redundant safety devices to limit 
pressure to less than 210 psi (1448 kPa). RediSep columns 
smaller than 100 g are CE certified using standard IEC61010-1 
for use on the CombiFlash Rf. RediSep columns larger than 
100 g meet Pressure Vessel Directive 97/23/EC. Teledyne Isco 
strongly recommends against the use of columns rated less 
than 210 psi (1448 kPa).

Note
For best results, always use RediSep Rf columns. The system will 
not automatically detect other columns, including non-Rf RediSep 
columns. The system also limits the maximum operating pressure 
to 50 psi when the column is not detected. 

1. Select a RediSep Rf column. The on-line help includes a 
column selection guide that can assist you in selecting a 
stationary phase media and column size.

2. Raise the injection valve (column mount for Rf 75 systems) 
and insert the column into the top column mount. Note 
that the column fittings are keyed to ensure the correct 
flow direction.

3. Slowly lower the injection valve while aligning the bottom 
column fitting. The spring-loaded injection valve will hold 
the column in place.

4. To seal the column fittings, give the column a slight twist 
(1/4 turn).
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Note
After loading a RediSep Rf column, the system will use RFID 
technology to automatically detect the media type and column 
size. PeakTrak displays the detected column size on the Main and 
Method Editor windows. If the system does not detect the column, 
manually select the column media and size.

5.3  Start a Default Method
After completing the system installation steps (Section 2 
through 4, as necessary), preparing the sample, and inserting 
the column, you are ready to perform a run with the default 
method. The system’s default methods are factory-set with run 
parameters typically used by chemists. Default methods are 
optimized for the use of RediSep Rf columns. The default 
settings will:

• collect all fluid in the fraction collector rack

• differentiate between UV (254 nm) vs. non-UV absorbing 
fluid and place the fluids into separate tubes

• cut UV absorbing peaks based on slope detection or level 
threshold.

To start the run from the PeakTrak Main window:

1. Enter a sample name. If you choose not to, PeakTrak will 
enter the date and time as the sample name when you start 
the run.

2. Review the PeakTrak Main window settings. If you want to 
change any settings, refer to the Editing a Method on-line 
help topic.

3. Click the Play button.

4. Select the sample Loading Type from the list. This Loading 
Type should support the sample preparation you chose in 
Section 5.1. Possible sample loading types for the Rf 200 
and Rf 4x systems are:

• Solid (Pause) – Select this option if you intend place 
the sample into a solid sample load cartridge, but 
have not yet prepared the sample. When you click the 
run button, the system will perform a column 
equilibration and then wait while you prepare the 
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cartridge. After you have placed the cartridge on the 
system, click OK to continue with the run. 

• Solid – Select this option if you have prepared the 
sample and placed it into a solid sample load 
cartridge. The system will proceed automatically 
until the end of the programmed run length.

• Liquid – Select this option if you have prepared a 
liquid sample and plan to manually inject it into the 
injection port after column equilibration. 

• None (on column) – Select this option if you have 
preloaded the sample on the column. The system will 
skip column equilibration so that the sample will not 
be flushed from the column before the run. 

Loading Type options for the Rf 75 system are:

• Equilibration – Select this option if you intend to 
equilibrate the column before introducing the liquid 
or solid sample.

• No Equilibration – Select this option to skip column 
equilibration. 

5. Review or update the Start Rack and Start Tube.

6. Review the Minimum Run Requirements. The system will 
report the estimated solvent volumes, expected waste, 
collection tube usage, etc. You can use this information to 
verify that there will be enough solvent to complete the 
run, the waste volume does not exceed the collection 
container’s capacity, and whether or not more tubes will be 
required during the run.

Note
The Rf 200 and Rf 4x systems estimate the solvent volumes by 
monitoring the solvent level in the container and the known usage 
rate. The systems continue to refine this estimate during 
operation. Solvent level sensing is not available on the Rf 75 
system.

Note
If the waste level sensing tube is inserted correctly into the waste 
container, the Rf 200 and Rf 4x systems will automatically 
suspend operation before an overflow condition might exist. To 
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prevent the run from being suspended before completing the run, 
ensure that the container will hold the expected waste volume. 
Waste level sensing is not available on the Rf 75 system.

7. Click OK and the run begins. The system responds 
according to the sample Loading Type you selected in 
step 4. 

Rf 200 and Rf 4x systems —

• If you selected Solid (Pause), the system 
equilibrates the column with the starting %B and 
then waits while you prepare the solid sample load 
cartridge. Place the cartridge on the system and click 
OK to continue. 

• If you selected Solid, the system equilibrates the 
column and immediately starts the separation. The 
prepared solid load cartridge should be in place 
before clicking the OK button.

• If you selected None (on Column), the system skips 
the equilibration and immediately starts the 
separation. The sample must be on the column before 
clicking the OK button. 

• If you selected Liquid, the system equilibrates the 
column and then waits. When instructed, perform the 
following steps: 

a. Place the injection syringe on the injection port.

b. Slowly force the liquid into the injection port. 

c. Chase the first injection with a second injection 
solution of at least 0.25 mL. The chase solution can 
be the starting mobile phase or diluted sample 
mixture.

d. Click OK to continue the run.

Rf 75 systems —

• If you selected Equilibration, ensure that the 
solvent delivery tubing is connected to the injection 
port above the column. When you click the OK 
button, the system equilibrates the column and then 
waits. When instructed, perform a liquid injection as 
described in steps a through d above, or attach the 
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solid sample cartridge to the injection port and 
connect the solvent delivery tubing. Click the OK 
button to continue.

• If you selected No Equilibration, ensure that the 
solvent delivery tubing is connected. The system 
starts the run immediately and assumes that the 
sample has been injected on the column or the solid 
load cartridge is in place. 

5.4  During the Run
You may allow system to proceed with the run while 
monitoring the progress on the PeakTrak main window. If 
desired, gradient parameters may be modified during the run. 
(See the Real-time Gradient Editing on-line help topic.)

As the run progresses, the absorbance trace is drawn on the 
Gradient Plot area. The separation or purification continues 
until the end of the run defined by the run length setting.

5.4.1  Run Control Buttons

You clicked the Play button to start the run. During the run, 
other run control buttons are active. 

• Pause — The Pause button holds the %B at the current 
value while the system continues to operate (sometimes 
called an isocratic hold). Note that pausing the run 
extends the run length. While in the Paused state, you 
can resume the run by clicking the Play button, or stop 
the run by clicking the Stop button. If you resume the 
run, the system continues with the gradient curve at the 
%B when the system was paused.

• Stop — This button suspends the entire run. Unlike the 
Paused state, the pump, peak detection, and fraction 
collection will not operate. While stopped, you can end 
the run by clicking the Rewind button, resume the run 
by clicking the Play button, or save the run data in a 
desired format by selecting the File>Save Run as PDF or 
Save Run as Text from the menu. 

Note
PeakTrak automatically saves all run history on the system’s 
internal hard drive in its native .RUN format. You can manually 
save a Run as Text or PDF while stopped or any later time as long 
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as the .RUN file has not been deleted. To automatically save a 
Text or PDF file after each run, configure the Network File Save 
feature (see section 6.1.3).

• Next Tube — This button advances the fraction 
collector to the next tube position. This allows you to 
conveniently collect eluate of interest in a new tube.

Note
When you click the Next Tube button, the system immediately 
marks the tube advance on the chromatogram. However, the 
system delays the movement of the drop former over the tubes. 
This delay accounts for the volume held in the tubing between the 
detector and the drop former, sometimes called the “delay 
volume.” It is important to remember that the chromatogram 
displays activity in real time while the fraction collector activity lags 
behind. The duration of this delay will vary with the flow rate.

• Rewind — This button is active when the system has 
completed the run, or if the run was stopped by clicking 
the Stop button. The Rewind button returns you to the 
Main window with the current method.

If you have stopped the run before its programmed run 
length has elapsed, clicking the Rewind button changes the 
current method to the new, shorter run length. This modi-
fied method is ready for the next run, or can be saved for 
future runs.

• Fast Forward — Click this button to jump to the next 
step of a run.

Once you have started a run, the system performs several 
steps. The first step is to deliver solvents using the pro-
grammed gradient for the entire run length. When this step 
is complete, the system will purge the column with air and 
clean the injection valve. Clicking the Fast Forward button 
will cause the system to skip any remaining time in the 
current step and advance to the beginning of the next step. 
Unlike the Rewind button, the clicking the Fast Forward 
button to complete the run will not modify the current 
method’s run length setting.
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Section 6 Remote Interfaces

This section provides instructions for controlling the 
CombiFlash Rf system through a remote interface. The system 
can be accessed by several personal computers through a 
corporate network, or by a single personal computer (PC) 
through a direct connection.

6.1  Network Configuration

Note
The procedures described in this section will require assistance 
from your network administrator. Contact your Information 
Technology department before proceeding.

The system has a factory-assigned IP address—192.168.1.51. 
In many cases, this address must be reconfigured for use on a 
corporate network. To reconfigure the IP address:

1. From the touch screen panel, select the 
Tools>Configuration menu command. 

2. The Configuration window has two tabs. Select the 
Network Configuration tab.

3. Select Static IP as the Network Type. 

4. Enter the IP Address, Netmask, and Gateway information 
provided by your network administrator

Note
Should your network administrator request the MAC address, a 
label on the system’s back panel lists the Address. You also can 
find the MAC Address on the Help>About PeakTrak window. 

5. Click the OK button to save the settings.
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6. Confirm that your network administrator has completed 
any necessary network changes to support the system. 

7. Locate the CAT5 connection cable (P/N 480-6545-01) in the 
accessory package. Insert one end into the Ethernet port on 
the back panel. Connect the other end of the cable to your 
network access port.

You should be able to connect to the CombiFlash Rf from a PC 
on the network (Section 6.1.1) or set up a network printer 
(Section 6.1.2).

6.1.1  Network PC Access

A successfully networked CombiFlash Rf system can be 
accessed by a PC that meets the recommendations listed in 
Table 6-1.

To access the system, simply open an Internet Browser and 
enter the IP address as “http://___.___.___.___”, where the 
blanks are replaced by the selected address. 

The browser window will load PeakTrak after you enter the 
address.

6.1.2  Network Printing

The CombiFlash Rf system can print to a network printer and 
supports both JetDirect and line printer (LPR) queues.

Consult with your network administrator to determine the IP 
address of selected printer. If the printer uses an LPR print 
queue, you must also find out the queue name. If the printer 

Table 6-1 Personal Computer Recommendationsa

Operating Systems: Microsoft Windows 2000, XP, or Vista

Hardware: The computer hardware must meet the minimum 
required specifications of the selected operating 
system. 

Network Protocol: TCP/IP

Network Connection: IEEE 802.3 (Ethernet) 

Display: 800 x 600 pixels, 256 colors, minimum

Internet Browser: Microsoft Internet Explorer 6.0 or later.

a. This table shows supported PC configurations. Other configurations or
AJAX-compatible browsers may be possible but are unsupported by Tele-
dyne Isco. 
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uses a JetDirect print queue, also ask for the port number. 
When this information is known, you can proceed with 
configuring system for network printing.

1. Select the Tools>Configuration menu command. 

2. The Configuration window has two tabs. Select the 
Network Configuration tab.

3. Follow the on-screen instructions for entering the address 
and queue information.

4. Click OK to save the settings. The CombiFlash Rf system 
will send a test page to the printer. 

After successfully printing a test page, the network printer 
will be available for printing using the File>Print menu 
command or through the Automatically Print Report at End of 
Run feature in the installation section. 

6.1.3  Network File Save Configuration

By default, this option is disabled and post-run reports are 
automatically saved internally on the CombiFlash Rf system. 
You can recall any run and view it from the system as long as 
the .RUN file has not been deleted. To save the post-run report 
for viewing elsewhere, you can save the run history as text or 
PDF files as needed. This Disabled option is useful when there 
is no need, or only an occasional need to save a run history file 
externally.

To save all run histories automatically as a text or PDF file, 
configure the Network File Save option. This allows the 
CombiFlash Rf system to access the corporate network and 
save the file in a selected Network Share folder. Consult with 
your network administrator to configure these fields. 

6.2  Direct Connection
A direct connection supports communication between the 
CombiFlash Rf system and a single PC that meets the 
recommendations in Table 6-1.

This guide provides instructions for Windows 2000 (section 
6.2.1), Windows XP (6.2.2), and Windows Vista (6.2.3). Refer 
to the applicable section, then follow the instructions in 
section 6.2.4 to complete the direct connection.
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Note
A direct connection requires a “crossover” CAT5 cable. Standard 
CAT5 network cables will not work. You can purchase a crossover 
cable locally or ask your Information Technology department to 
assemble one. You can also order a crossover cable (part number 
480-6545-02) from Teledyne Isco.

Note
These instructions assume that the system is using the factory-set 
IP address of 192.168.1.51.

Note
The following instructions may require a user account with 
Administrator privileges on the PC. If you cannot modify the 
settings in sections 6.2.1 through 6.2.3, contact your Information 
Technology department.

6.2.1  Windows 2000 Settings

1. From the Windows Start button, select “Settings>Control 
Panel” to view the control panels.

2. Locate the “Network and Dial-up Connections” icon and 
open this control panel. 

3. Highlight the “Local Area Connection” icon. View the 
properties by right-clicking and selecting “Properties.” The 
Local Area Connection Properties Window will open 
(Figure 6-1).

4. Highlight the “Internet Protocol (TCP/IP)” item in the list, 
and click on the “Properties” button. The Internet Protocol 
Properties Window will open (Figure 6-2). 

Note
The following steps change the local area connection settings. If 
the PC must be restored to its original network configuration, 
record the present Internet Protocol (TCP/IP) settings now.

5. Click the “Use the following IP address” option. 

6. Enter the IP address “192.168.1.200”. 

7. Enter the default Subnet Mask “255.255.255.0.” 
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8. Click the OK button to close the Internet Protocol 
properties window. Then, click the OK button to close the 
Local Area Connection properties window. 

9. Shut down the PC and place the CombiFlash Rf system in 
Standby.

Figure 6-1  Local Area Connection Properties Window

Figure 6-2  Internet Protocol Properties Window
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6.2.2  Windows XP Settings

1. From the Windows Start button, open the Control Panel.

2. Locate the Network Connection icon and open this control 
panel.

3. Highlight the “LAN or High-speed Internet Connection” 
icon. Select the “Change settings of this connection” option, 
or right-click and select “Properties.” Refer to Figure 6-3. 

4. Highlight the “Internet Protocol (TCP/IP)” item in the list, 
and click on the “Properties” button. Refer to Figure 6-4.

5. Select the Alternate Configuration tab. Click the “User 
Configured” option. See Figure 6-5.

6. Enter the IP address “192.168.1.200”. 

7. Enter the Subnet Mask, “255.255.255.0.” 

8. Click the OK button to close the Internet Protocol 
properties window. Click the Close button to close the 
Local Area Connection properties window. 

9. Shut down the PC and place the CombiFlash Rf system in 
Standby.

Figure 6-3  LAN or High-speed Internet Connection
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Figure 6-4  Local Area Connection Properties

Figure 6-5  Alternate Configuration Settings
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6.2.3  Windows Vista Settings

1. From the Windows Start menu, right-click on Network, 
then select the Properties menu option. The PC displays 
the Network and Sharing Center.

2. Under Tasks, select Manage Network Connections.

3. Right-click on the Local Area Connection icon and select 
the Properties option. After you provide permission to 
continue, the PC displays the Local Area Connection 
Properties window (Figure 6-6). 

4. Select Internet Protocol Version 4 (TCP/IPv4), then click 
the Properties button. The PC displays the Internet 
Protocol Version 4 (TCP/IPv4) Properties window 
(Figure 6-7).

Figure 6-6  Local Area Connection Properties
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Figure 6-7  Internet Protocol Version 4 (TCP/IPv4) Properties

Note
If the Internet Protocol Version 4 (TCP/IPv4) option is not listed, 
click the Install button to add it. If assistance is needed, press the 
F1 keyboard button to display Windows Vista Help.

Note
The following steps change the local area connection settings. If 
the PC must be restored to its original network configuration, 
record the present Internet Protocol (TCP/IP) settings now.

5. Select the “Use the following IP address” option.

6. Enter the IP address “192.168.1.200”. 

7. Enter the Subnet Mask, “255.255.255.0.” 

8. Click the OK button to close the Internet Protocol Version 
4 (TCP/IPv4) Properties window. Click the OK button to 
close the Local Area Connection properties window. 

9. Shut down the PC and place the CombiFlash Rf system in 
Standby.
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6.2.4  Completing the Direct Connection

1. Connect the PC to the CombiFlash Rf system using the 
cross-over cable.

2. Turn the system’s On/Standby switch to ON. Wait for the 
PeakTrak operating screen to appear on the CombiFlash 
Rf system, then start the PC.

3. Start Internet Explorer and type the factory default 
address “http://192.168.1.51”. The browser will display the 
PeakTrak screen.

Note
The PeakTrak screen indicates that the direct connection is 
working.

The CombiFlash Rf system and the PC are now configured for 
communication through a direct connection. Refer to 
PeakTrak’s on-line help for operating instructions. 
Abbreviated instructions can be found in Section 5 of this 
guide.
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Section 7 Maintenance

7.1  System Standby and Shut Down 
During extended periods of inactivity, you can place the 
system in Standby to conserve power. To do so, log off the 
system (File> Log out) and place the On/Standby switch in 
Standby.

When in the Standby state, normal system operation is no 
longer available from the touch screen or remotely. However, 
some internal components are still powered. 

WARNING
As long as the AC mains power cord is connected, power is 
inside the unit. The mains power cord is the disconnect device. 
Position the CombiFlash Rf system so that the power cord can 
be unplugged, or use a power strip where the plug can quickly 
be removed from the outlet in the event of an emergency. 

When you first place the system in Standby, internal 
components continue to operate for almost one minute while 
performing file maintenance and preparing the system for 
possible power removal.

CAUTION
Removing the AC mains power cord before the file maintenance is 
complete might corrupt files on the internal hard drive. These 
corrupted files can cause abnormal operation or a complete 
system failure that requires service. Unless power must be 
removed due to an emergency, always wait at least one minute 
after placing the system in Standby before removing the AC mains 
power cord.
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7.2  Preventive Maintenance
The system requires preventive maintenance for safe and 
reliable operation. Refer to the schedule below for the 
minimum periodic maintenance requirements.

As Needed – Perform these tasks as conditions require:

• Cleaning (section 7.3).

• Quick flow cell cleaning when recommended by a system 
alert message (section 7.5.2).

Every Run – Allow the separation run to finish with a high 
percentage of solvent B to flush residual compounds from the 
column, internal tubing, and flow cell. Refer to section 7.5.1.

Monthly – Perform these tasks at least monthly, more 
frequently if conditions warrant:

• Tubing Inspection (section 7.4).

• Collection rack and tray cleaning (section 7.3.1).

• Monthly flow cell cleaning (section 7.5.3).

7.3  Cleaning
To clean the exterior surfaces, use a cleaning cloth dampened 
with a mixture of distilled water and a mild detergent. Use 
isopropyl alcohol for tougher stains. 

On printed areas such as labels, avoid rubbing vigorously or 
using aggressive solvents like acetone. Each will ruin the 
printed text.

CAUTION
Do not immerse the instrument in a water bath or subject it to a 
liquid spray. The instrument is not watertight and these actions 
could damage the internal electronics.
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7.3.1  Collection Rack and Tray Cleaning

WARNING
Risk of fire or equipment damage. Unclean collection racks and 
tray might inhibit their conductive properties. The racks and 
tray must be kept clean to dissipate static electricity.

The collection tube racks and tray are made of conductive 
plastic. Dirt, film, or coatings might prevent their ability to 
dissipate static electricity. To avoid problems that possibly 
result from an electrostatic discharge, clean the racks and tray 
monthly. Use distilled water with a mild detergent. For 
tougher stains, use isopropyl alcohol.

7.4  Tubing Inspection

WARNING
Risk of fire or equipment damage. Faulty tubing, fittings, and 
drains may allow organic solvents to pool in unsafe areas, 
creating a potential for dangerous levels of flammable vapors. 
Improper draining may damage the instrument’s internal 
components.

Perform a tubing inspection monthly:

1. Visually inspect the solvent, waste, and drain tubing. The 
tubing must be free of any damage, kinks, or deterioration. 
Fittings should show no signs of leaks.

2. Test the collection tray drain and top shelf drain by 
connecting a vacuum or air supply source to the outlet end 
of the drain tubes. Then, verify the presence of such 
vacuum or air supply source on the drain hole (Figures 7-1 
and 7-2).

Correct any deficiencies before returning the instrument to 
operation.
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Figure 7-1  Collector tray drain hole

Figure 7-2  Top shelf drain hole

Vacuum or 
pressurized air 
applied to the outlet 
end of the drain 
tube must exist at 
the collection tray 
drain hole.

Vacuum or 
pressurized air 
applied to the outlet 
end of the drain 
tube must exist at 
the top shelf drain 
hole.
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7.5  Flow Cell Cleaning

7.5.1  Post Separation

As a preventive measure, all default column methods finish 
the separation run with a high percentage of solvent B 
(Figure 7-3). This brief time (two to three column volumes) of 
strong solvent flushes residual compounds from the column, 
flow cell, and internal tubing.

Figure 7-3  Default post-separation column and flow cell flush

Skipping the post-separation flush may cause residual 
compounds to build up and crystallize, which might result in:

• cross contaminating later separation runs

• higher operating pressures

• reduced flow cell lamp energy

• a noisy baseline on the absorbance trace

• frequent messages recommending flow cell cleaning 
(Figure 7-4).

Typically, chemists Stop and then Fast Forward the run after 
the last compound elutes. This action skips the 
post-separation flush. If any of the above conditions appear, 
consider allowing some of the runs to continue through the 
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flush, or run a high percentage of %B solvent through the 
system for a few minutes at the end of each day. 

If the separation runs always continue through the flush and 
the conditions still occur frequently, edit the default column 
methods to extend the flush duration. 

CAUTION
When using methanol as solvent B with silica column media, do 
not pump more than 50% solvent B. Higher percentages of 
methanol might break down the silica structure, possibly causing 
obstructions in the flow path.

7.5.2  Quick Cleaning when Recommended

When the lamp energy is lower than normal, the system will 
recommend flow cell cleaning (Figure 7-4) before starting a 
separation run.

Figure 7-4  Flow cell cleaning message

When the system displays this message you can:

• Cancel Run (recommended) – Click the Cancel Run 
button so you can perform a quick cleaning described in 
the following steps.

• Continue Collect All – Click this button to ignore the 
message. Because the peak detection operation might be 
impaired, the system automatically collects all fluids to 
avoid diverting compounds of interest to waste.

• Help – Click this button to display the flow cell cleaning 
on-line help topic.

To perform a quick cleaning:
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1. After clicking the Cancel Run button, select the 
Tools>Manual Control menu option.

2. From the Manual Control window (Figure 7-5), note the 
Raw Lamp Energy level at 254 nm. The Raw Lamp Energy 
gauge has three ranges: red, yellow, and green.

Figure 7-5  Raw Lamp Energy Gauge

• Red – lamp energy is obstructed to a degree that the 
system might not reliably detect peaks. If you 
attempt to operate the system, peak collection will be 
forced to collect all. This prevents diverting desired 
compounds to waste.

• Yellow – lamp energy is partially obstructed and the 
peak detector performance might be impaired. The 
system can be operated although the absorbance 
trace might appear noisy. Yellow might be a normal 
indication for systems with flow cell windows stained 
by compounds.

• Green – lamp energy is sufficient to detect peaks up 
to 2.4 Absorbance Units.

3. Remove the column and insert a bypass tube between the 
upper and lower column mounts. A bypass tube (P/N 
209-0165-46) can be found in the accessory kit 
(P/N 60-5239-006).

4. Set the Flow Rate to 40 mL/min (Figure 7-6).
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Figure 7-6  Manual Control Settings - Quick Cleaning

5. Select Through column for the Valve Position option.

6. Select Next for the Pump into Tube # option. By pumping 
into a collection tube, the diverter valve is also cleaned of 
any residue during this operation.

7. Click the Prime B button to pump 100% Solvent B through 
the bypass tube and into the collection tubes.

Note
Pumping solvent B at a moderate flow rate (25 to 45 mL/min) over 
time will usually solubilize obstructions. Generally, the 
recommended solvent is the highest polarity solvent you have 
recently used (solvent B).

8. Monitor the Raw Lamp Energy gauge. As the system 
pumps solvent, the raw lamp energy should gradually 
improve. Pump solvent for two to five minutes or until the 
indicator reaches the far-right of the green range.

When the indicator is in the yellow, the lamp energy and flow 
cell are ready for the next run. However, continuing the 
cleaning for greater raw lamp energy should reduce the 
frequency of flow cell cleaning messages (Figure 7-4).

If after five minutes the indicator is still in the red range, 
repeat the cleaning steps using an alternative solvent 
(Table 7-1). Or, complete the steps in the Monthly Flow Cell 
Cleaning procedure (section 7.5.3).
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Note
If the numerical values of the Raw Lamp Energy (Figure 7-5) do 
not change, or if the first number remains at zero, contact 
Teledyne Isco’s Technical Service department.

Table 7-1 Suggested Flow Cell Cleaning Solventsa

Solvent Description

Methanol Miscible with most LC solvents. Methanol will force other 
solvents through the system so they will not interfere with 
the next sample. It breaks down the tertiary structure of 
silica and allows it to flush through.

Acetone Common organic solvent with high dissolving properties. 
Acetone absorbs UV light at 254 nm. Therefore, the Raw 
Lamp Energy gauge will always read red when acetone is 
in the flow cell. After pumping acetone, pump a different 
solvent through the system to remove the acetone and 
read the Raw Lamp Energy gauge.

Dichloromethane 
(DCM)

Effective at solubilizing organic molecules.

Dimethylsulfoxide 
(DMSO)

Strong solvent that will clear organic sample.

Dimethylformamide 
(DMF)

Strong solvent if other solvents do not produce the 
desired results.

Tetrahydrofuran 
(THF)

Strong solvent.

Water/DMF/
methanol

A 50/25/25 solvent mixture effective in clearing some 
obstructions.

Water/DMF/
Acetic Acid

30/30/30ml solvent mixture effective in clearing some 
obstructions.

Mildly acidic 
aqueous solution

0.5M acetic acid in distilled water can be used to clear 
samples that are not removed by organic solvents.

Mildly basic 
aqueous solution

A dish-type detergent solution can wash through 
particulates not picked up by the acidic solution. The 
emulsification effect of detergent is an effective tool as 
well to help wash through oily samples. Follow the 
detergent with several minutes of clean, distilled water.

a. Recent synthesis solvents should also be considered.
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7.5.3  Monthly Flow Cell Cleaning

Perform this procedure as part of your scheduled preventive 
maintenance, or when Quick Cleaning As Required (section 
7.5.2) does not improve the lamp energy.

1. Remove the column and insert a bypass tube between the 
upper and lower column mounts. A bypass tube 
(209-0165-46) can be found in the accessory kit 
(60-5239-006).

2. From the menu, select Tools>Manual Control. This opens 
the Manual Control window.

3. Set the Flow Rate to 40 mL/min (Figure 7-6).

4. Select Through column for the Valve Position option.

5. Select Next for the Pump into Tube # option.

6. Place the B1 Solvent inlet line into a reservoir of methanol, 
acetone, or a strong solvent that readily dissolves residual 
sample material. 

7. Click the Prime B button to pump 100% Solvent B through 
the bypass tube and into the collection tubes. 

8. After three minutes, click the Stop button. Allow the 
system to stand for at least six hours. Overnight is 
recommended.

9. Return the B1 solvent line to the original solvent container. 

10.Perform the Quick Cleaning as Required (section 7.5.2) and 
monitor the Raw Lamp Energy.

If the lamp energy is in the green or yellow range, return 
the system to operation. If the lamp energy is red, contact 
Teledyne Isco’s Technical Service department for assis-
tance.

7.6  Injection Valve Maintenance
CombiFlash Rf 200 and Rf 4x systems have an automatic 
injection valve. Under normal operating conditions, this 
self-cleaning valve does not require any maintenance. 

The valve and its fittings are very sensitive. Should there be a 
need to replace any of the fittings, use care to avoid 
overtightening the fitting and damaging the valve. 
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CAUTION
Over-tightening connections to the automatic six-port injection 
valve may cause leaks or permanently damage internal valve 
components. Unless you are using factory-recommend torque 
wrenches and adaptors, never use tools or tighten a fitting more 
than finger tight. 

All connections to the injection valve seat against a cylindrical 
PTFE seal. To seal all six fittings the shape of the seal must be 
perfectly round. Consequently, all fittings must be tightened 
with equal pressure. Over- or under-tightening any one fitting 
will deform the round shape of the seal and cause leaks. 

If a leak cannot be stopped, the field procedure below may be 
used.

1. Stop the pump. 

2. Loosen the jam nuts on the metal Luer fittings. 

3. Loosen all six fittings without removing them completely. 

4. Using the pattern in Figure 7-7, finger-tighten the fittings 
until they first seat against the PTFE seal. The pattern 
begins with the injection port. 

Figure 7-7  Torque pattern

5. Using the same torque pattern, finger-tighten the fittings 
an additional 1/8-turn.

6. While holding the metal Luer fitting in place with a 5/16" 
wrench, tighten the jam nut with a 3/8" wrench until it is 
snug against the valve body.

7. Open the Manual Control window and pump solvent 
through all flow paths while observing for leaks. 
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If the valve does not leak, stop the pump and return the 
system to operation. 

If the valve still leaks, repeat the tightening procedure one 
more time: 

8. Loosen the jam nuts while holding the fitting in place. 

9. Using the torque pattern, finger-tighten the fittings an 
additional 1/8-turn. Then, tighten the jam nuts. 

10.Open the Manual Control window and pump solvent 
through all flow paths while observing for leaks. 

If the valve does not leak, stop the pump and return the 
system to operation. Otherwise, contact the factory for 
assistance. 

Note
If the field procedure does not correct the leak, a factory 
procedure (60-5232-475) is available. This factory procedure 
requires special tools: a single-use torque wrench (490-0014-34) 
and a wrench adaptor for the Luer fittings (60-5234-204). 

7.7  Electrical Troubleshooting
If your instrument stops working and the touch panel display 
is off, check the line cord connection.

If the line cord is connected properly, check the fuses in the 
power input module located on the system’s rear panel. These 
are time delay fuses (T-type) and rated according to the mains 
input power voltage: 

• 100 to 129 VAC mains input: 2.0 A fuse

• 215 to 264 VAC mains input: 1.0 A fuse.

CAUTION
Always replace fuses with the same type and rating. 
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Companion with Touchscreen Hazmat Table    60-5233-406   Rev.  

Name and amount of Hazardous Substances or Elements in the product 

Hazardous Substances or Elements 
Component Name 

(Pb) (Hg) (Cd) (Cr(VI)) (PBB) (PBDE)

LCD Display 
O X O O O O 

Circuit boards 
X O O O O O 

Wiring
O O O O X O 

Internal Cables 
O O O O X O 

Line Cord 
O O O O X O 

Stepper Motor 
X O O O X O 

Deuterium lamp 
O O X O O O 

Valve Body 
O O O O X O 

Name and amount of Hazardous Substances or Elements in the product 

O: ST/
O: Represent the concentration of the hazardous substance in this component’s any homogeneous pieces is lower than the 

ST/ standard limitation. 

X ST/ 

( “X” )
X: Represent the concentration of the hazardous substance in this component’s at least one homogeneous piece is higher 

than the ST/ standard limitation. 
(Manufacturer may give technical reasons to the “X” marks) 

The Environmentally Friendly Use Period (EFUP) was determined through experience. 

(207 2007 ) A

B
The date of Manufacture is in code within the serial number.  The first three numbers are the year of manufacture (207 is 
year 2007) followed by a letter for the month. "A" is January, "B" is February and so on. 





Teledyne Isco One Year Limited Warranty* 
Factory Service for Teledyne Isco CombiFlash®  Systems 

This warranty exclusively covers Teledyne Isco 
CombiFlash® instruments, providing a one-year limited 
warranty covering parts and labor. 

the customer will pay to return the instrument to Teledyne 
Isco, and Teledyne Isco will pay surface transportation to 
return the repaired instrument to the customer. Teledyne 
Isco will not pay air freight or customer’s packing and 
crating charges. This warranty does not cover loss, damage, 
or defects resulting from transportation between the 
customer’s facility and the repair facility. 

Any instrument that fails during the warranty period due to 
faulty parts or workmanship will be repaired at the factory at 
no charge to the customer. Teledyne Isco’s exclusive 
liability is limited to repair or replacement of defective 
instruments. Teledyne Isco is not liable for consequential 
damages.

The warranty for any instrument is the one in effect on date 
of shipment. The warranty period begins on the shipping 
date, unless Teledyne Isco agrees in writing to a different 
date.

CombiFlash systems are designed to use Teledyne Isco 
RediSep columns. RediSep columns lead the industry in 
quality and performance.  Customers may use other brands 
of columns on their CombiFlash instruments. These non-
RediSep columns may fail to separate compounds, may leak 
silica into the flow path of the CombiFlash instrument, and 
may leak solvents from their fittings and seals.  

Excluded from this warranty are normal wear; expendable 
items such as charts, ribbon, lamps, tubing, and glassware; 
fittings and wetted parts of valves; and damage due to 
corrosion, misuse, accident, or lack of proper maintenance. 
This warranty does not cover products not sold under the 
Teledyne Isco trademark or for which any other warranty is 
specifically stated.   Damage to CombiFlash instruments resulting from the 

failure of a non-RediSep column may cause the need for 
repairs that incur billable service activities. The customer is 
responsible for these charges. 

This warranty is expressly in lieu of all other warranties 
and obligations and Teledyne Isco specifically disclaims 
any warranty of merchantability or fitness for a 
particular purpose. Teledyne Isco will pay surface transportation charges both 

ways within the 48 contiguous United States if the 
instrument proves to be defective within 30 days of 
shipment. Throughout the remainder of the warranty  period, 

The warrantor is Teledyne Isco, Inc. 4700 Superior, Lincoln, 
NE 68504, U.S.A. 

* This warranty applies to the USA and countries where Teledyne Isco Inc. does not have an authorized dealer. Customers in countries 
outside the USA, where Teledyne Isco has an authorized dealer, should contact their Teledyne Isco dealer for warranty service. 

Before returning any instrument for repair, please call, fax, or e-mail the Teledyne Isco Service 
Department for instructions. Many problems can often be diagnosed and corrected over the 
phone, or by e-mail, without returning the instrument to the factory. 

Instruments needing factory repair should be packed carefully, preferably in the original carton, 
and shipped to the attention of the service department. Small, non-fragile items can be sent by 
insured parcel post. PLEASE BE SURE TO ENCLOSE A NOTE EXPLAINING THE DEFECT.

 Shipping Address: Teledyne Isco, Inc. - Attention Repair Service 
4700 Superior Street 
Lincoln NE 68504 USA 

Mailing address: Teledyne Isco, Inc. 
PO Box 82531 
Lincoln NE 68501 USA 

Phone: Repair service:  (800)775-2965 (lab instruments)

 (800)228-4373 (samplers & flow meters) 

Sales & General Information (800)228-4373 (USA & Canada)

 Fax: (402) 465-3001 

 Email: iscoservice@teledyne.com   Web site:   www.isco.com 

February 1, 2006  P/N 60-2132-281 Rev C 
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